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Introduction 
 

HeavyMetal Map Description 
HeavyMetal Map is the ideal program for use in designing and printing hex-
based maps for Classic BattleTech game play. Features such as the ability to 
print multi-sheet and oversize maps and the Random Map Designer feature 
make using the program both satisfying and fun. 

Other features include: 

 Over 1,000 high-quality graphics are included with the program, 
organized into palettes, so as to accommodate computers of various 
capabilities. 

 In addition to printing maps, an optional Map Information Sheet can be 
printed, which outlines all the items on the map sheet, along with their 
location, rules and a sample graphic. 

 Add-On graphics allow scaling of any graphic, such as a DropShip, to 
cover multiple hexes and print basically any size desired. 

 All official terrain types are included, and in addition many new 
graphics, such as railroad, Maglev monorail and canal are provided. You 
can easily add your own graphics as well. 

 Graphics are added in layers, with over ten layers providing great 
flexibility and the ability to add several different items within the same 
hex or area. 

 Palettes of graphics are provided, and can be added or customized by the 
user, to use different groups of graphics to meet the requirements of 
different maps. 

 HeavyMetal Map includes a Random Map Designer feature, which can 
place woods, lakes, shores, rough and levels in random locations on the 
map. Choose the percent of each terrain type, or let HMMap do its own 
thing with the “I’m feeling lucky” feature. 

 Most or all of the standard published maps are already entered in for 
you; print them out, or use them as a basis for making your new designs. 

 You have complete control over the printout, including the type and 
color of hex lines and text that is printed on the map. You can even 
choose to include building rating, CF and height, rating and height only, 
height only, or none of the above (in case you only want your 
Gamemaster to know). 

 Zoom in while working on the map, or view the entire map at once. 
Either way, full resolution map previews are available at the touch of a 
function key. 
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 Maps can be automatically printed to multiple sheets (as standard size 
maps rarely fit on a single sheet), or high-resolution images can be made 
for printing at a print shop or for other uses. 

HeavyMetal Map User's Guide  Page 11 of 91 



 

Getting Started 

System Requirements 
Operating System 

HeavyMetal Map has been designed and tested to run only on Microsoft 
Windows® 95, 98, 98se, 2000, XP home and XP Professional. Windows 2000 
or XP are suggested, due to much better handling of Windows resources 
including memory. While it may be possible to run the program on Macintosh 
computers using Windows emulators, that functionality is not guaranteed and 
support for non-Windows native systems will be limited if available at all. 

Pentium® Class Processor 
A Pentium® or comparable processor is required for operation of the program. 

Video Settings 
Setting Video 

Video settings can be reached for viewing or modification in two ways: Right-
clicking on the Desktop and selecting Properties from the popup menu, or 
opening Control Panel (Start > Settings > Control Panel) and double-clicking on 
Display. The most important settings are on the Display tab of this dialog box. 

Resolution Settings 
HeavyMetal Map requires fairly high screen resolution for most ease of use. 
With lower resolutions, more screen real estate is used for buttons and other user 
interface items, and less for the map. Although you can run HeavyMetal Map 
with as little as 800 x 600 pixel screen resolution, the minimum recommended 
screen resolution is 1024 x 768 pixels, as set by the Screen Area slider on the 
Display Properties Settings tab. If your monitor, and eyes, allow for it, a screen 
resolution of 1280 x 1024 or even higher can be used to great advantage. Higher 
resolutions allow you to more easily put much more on your screen, including 
multiple programs, but everything is smaller, and you need to be able to read the 
text as well. 

Please note that the above resolution recommendation is based on the Small 
Fonts setting (below) in Windows; using a larger font setting will increase the 
minimum screen resolution. 
Note: HeavyMetal Map can take advantage of any large resolution setting, to show 

the map design area larger, and show more of the available graphics. You 
will probably find that running the program in maximized mode is really the 
method to use, so much so that the program always starts in that mode. 

Font Settings 
As Windows ships, it uses the Small Fonts setting, so if you’ve never made a 
change, that’s what setting will be used. Some people, when using higher screen 
resolutions, prefer a larger font size to go along with it. This is fine, but doing so 
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also increases the space required for buttons and other such items, and it may be 
necessary to bump up the resolution a bit to compensate. This is also done from 
the Settings tab of the Display Properties screen, by clicking on the Advanced 
button, then choosing the desired font size. Note that you may have to restart 
your computer after making this change. 

Color Settings 
HeavyMetal Map requires at least 16-bit color (also called High Color, and 
having over 64,000 colors) to display graphics properly. Running in 256 color 
mode will result in very ugly graphics, since even though GIF images used by 
the program are limited to 256 colors, each graphic can use a different group of 
256 colors. So be sure your Color setting is 16-bit or higher, as indicated again 
on the Settings tab. 

Memory Requirements 
HeavyMetal Map uses a lot of memory. Not the program, so much, but all the 
graphics loaded in memory for use, as well as a lot more when creating images 
to be saved. After loading the three standard palettes, HeavyMetal Map uses 
about 85 MB of memory, so you should have 85-100 MB free memory 
available. You can get by with less by not using the more advanced palettes 
(more on palettes later), but having insufficient memory will slow your 
computer down, as memory must then be swapped to your hard drive (virtual 
memory), which is much slower than RAM. 
Note: To check the available memory after starting Windows, using Windows 2000 

or Windows XP, right-click on an empty space in the task bar and choose 
Task Manager from the popup menu, or press Ctrl-Alt-Del and pres the Task 
Manager button. The Performance tab of the Windows Task Manager 
displays the Physical Memory available for running HeavyMetal Map or any 
program. 

Printing maps takes no additional memory, however saving maps as JPG images 
does. As much as 100 MB of memory per map sheet can be used, when in high-
resolution mode, and with the ability to make a hi-res 4-map combination image, 
that means an additional 400 MB of memory may be required, making a total of 
close to 500 MB total memory usage. That doesn’t mean you need that much 
memory, but you could certainly use it, depending on what you do with 
HeavyMetal Map. RAM is cheap, these days, and you may want to consider a 
memory upgrade, if your computer doesn’t have enough. 

Hard Drive Requirements 
A full install of HeavyMetal Map consumes approximately 75 MB of space, 
including runtime files. The vast majority of this is used by the graphic images 
which are used to make and print maps. You'll probably want extra space to add 
your own palettes, however, which can take up as much as 20 MB each, so extra 
room is a plus. 
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Printers 
HeavyMetal Map supports any Windows printer, and can print even standard 
size map sheets using any printer, although you’ll have to trim and tape the 
separate sheets together. You can also use large format printers, if available, 
which can even allow you to print an entire map on a single large sheet. As most 
Classic BattleTech maps are 18” x 22”, printers to print that size map as a single 
sheet are usually beyond the reach of most of us. However, image files can be 
taken to your local printer and printed, printouts can be reduced in size to 
accommodate the printer available and sheets can be combined to make larger 
maps. 

CD Drive 
HeavyMetal Map is available in two formats: file download and on CD-ROM. 
For the CD version, a CD drive is required to read and install the software. 

Mouse 
Due to the highly graphic nature of the program, HeavyMetal Map requires the 
use of a mouse or other type of pointing device such as a trackball. It is not 
practical to run the program using only a keyboard. 

Installing the Software 
Note: You must be a local administrator on your PC in order to install this or any 

software properly. For most home users, you will already be considered an 
administrator, and that shouldn’t be a problem. Some computers are set up 
with separate accounts, however, so be sure that the account you use does 
have administrative privileges before proceeding. 

Starting the Startup Program 
Installing from CD-ROM 

Normally, after inserting the CD in the CD drive, the startup program will 
automatically begin the installation process. 
Note: If the installation program does not start automatically, double-click on the 

My Computer icon, and then double-click on the CD-ROM icon. When the 
window opens displaying the contents of the CD-ROM, double-click 
Autorun.exe. 

Installing from File Download 
If you downloaded the software, rather than receiving a CD, you will have a 
single executable (ending in .EXE) program. After downloading the software, 
browse to the location of the file using Windows Explorer and double-click on it 
to run the startup program. 

The Startup Screen 
The Startup screen has several choices: 

Install 
Install the HeavyMetal Map on your computer. 
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Readme 
Read the Readme files, which contains basic startup instructions and other 
information. 

User’s Guide 
Read or print the User’s Guide (this document). Please note that the User’s 
Guide is in Adobe PDF format and requires Adobe Acrobat Reader or another 
PDF reader program. 

Browse CD 
Browse the CD using Windows Explorer. Although this indicates it is browsing 
the CD, even in the case of a download you can browse through the files, just as 
if it were actually on a CD. 

Web Links 
The Web links page gives several web links you might be interested in, such as 
the HeavyMetal software home page, program updates page, newsgroup and 
forums. 

Legal Info 
This page lists legal and copyright information. Please read and understand it, as 
well as the End User License Agreement, located both in this guide and during 
the program installation. 

Exit 
Exits the Startup program. You will need to exit this screen after you have 
installed the software, and/or used any of its other features. 

Installing HeavyMetal Map 
After clicking on the Install button, the HeavyMetal Map setup program will 
start. Continue to install the program by following the screens and instructions 
presented: 

Welcome! 
The welcome screen asks for confirmation that you want to install the program 
and recommends that you exit other programs that may be running. Click Next 
to continue. 

Copyright Information 
This screen displays the copyright information for the program, as well as for 
Microsoft and WizKids Inc. Please read this important information, which is 
repeated at the end of this document. Click Next to continue. 

License Agreement 
The End User License Agreement is a very important component of the 
installation. Please do not install this software until you read and understand this 
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agreement. Continuing with the installation is possible only by indicating 
agreement. After reading and confirming agreement, click Next. 

User Information 
Enter your user information and click Next. 

Select Packages 
Select the components of the program that you wish to install, and note the 
space required on the hard drive(s). For a first-time install, always be sure that 
all components or packages are selected. Without all the required data, 
HeavyMetal Map will not be able to run. At a later date, if you wish to reinstall 
only certain components, you may want to select only them. Click Next to 
continue. 

Installation Folder 
Enter or confirm the installation folder into which you want to install the 
program. Normally this will be c:\Program Files\HeavyMetal\Map, but you can 
change it if desired. Again, the space required for the installation on the data and 
Windows drives will be indicated. Click Next to continue. 

Shortcut Folder 
Enter or confirm the Start Menu shortcut folder in which to place the 
HeavyMetal Map shortcut to start the program and other options. This will be 
set to HeavyMetal\HeavyMetal Map by default, but you can change it if you 
like. The default arrangement will group all of your HeavyMetal programs into a 
single HeavyMetal folder. 

You can also choose to install the shortcuts for everyone who uses this 
computer, or only for the current user. Click Next to continue once you are 
satisfied with the folder. 

Ready to Install 
Glance over your selections, to be sure have selected the install folder and other 
options they way you want them, and once you’re sure, click Install to continue 
with the installation. 

Installation Complete 
The final screen notifies you that the installation has been successfully 
completed. Click Exit to leave the Setup program. 

Uninstalling HeavyMetal Map 
Shame on you for even thinking about it! But, just in case you need to install 
HeavyMetal Map to a new computer and therefore need to uninstall it from your 
old one, you can uninstall the program just by choosing the Uninstall 
HeavyMetal Map menu selection in the HeavyMetal Map Start menu. You can 
also uninstall from Control Panel > Add/Remove Programs. Please note that 
when uninstalling the program, there may be graphics or information that you 
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have added to the HeavyMetal Map folders; therefore, you may want to check 
this out using Explorer and deleting any files you no longer need. 

Getting Help 
Several methods of obtaining help for HeavyMetal Map have been provided for 
your use: 

User’s Guide 
This User’s Guide (this document) provides a wealth of information, and if read 
completely, should answer most questions you may have. HeavyMetal Map is 
an easy program to use, but it has a depth of operation beyond what may be 
readily apparent; by reading the guide, in particular the sections on Palettes and 
Levels, you will better understand the program and get the most out of it. 

Please note that this guide also includes full instructions on how to install, 
configure and uninstall the program. Please check the User’s Guide before 
seeking support elsewhere. 
Note: The main source of help for HeavyMetal Map is considered to be the User’s 

Guide, so the program does not have a traditional help file associated with it. 
The advantages of the User’s Guide include the fact that it can be browsed 
more easily, printed if desired and does not require the program to be running 
to be used. In addition, examples with pictures are possible that would not be 
practical with a traditional help file. 

Email 
You may email tech support at support@heavymetalpro.com. We are very 
pleased with our response to tech support questions, and usually you will receive 
a response within 24 hours. 

Forums 
The HeavyMetal forums are an excellent place to trade ideas, ask questions 
(about support, program operations or Classic BattleTech in general) or just 
socialize with others of similar interests. You can read more about the forums, 
as well as browse to them, by going to: 

http://www.heavymetalpro.com/forums_new.htm

Newsgroup 
While technically not designed for support, you will want to join the 
HeavyMetal Software newsgroup. You will then receive occasional (normally 
less than one a month) updates on program changes and updates, new data files 
that may be available and upcoming developments. Rest assured that we will 
never spam you with information you don’t want, nor will we give or sell any 
information about you to anyone else. Read more about the newsgroup at: 

http://www.heavymetalpro.com/Newsletter.htm
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FAQ 
In addition to the FAQ (Frequently Asked Questions) contained within this 
User’s Guide, you may also find information online at the HeavyMetalPro.com 
web site FAQ: 

http://www.heavymetalpro.com/faqnew.htm

Phone Support 
Telephone support is not available for HeavyMetal products, due to the nature of 
our company. We feel we can serve you much better using email, but if you 
desire, you can also FAX us at 419.793.5000. 
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Getting to Know The Program 

Starting and Exiting HeavyMetal Map 
Starting HeavyMetal Map 

Starting using the Start Menu 
The HeavyMetal Map setup program installs as shortcut on your Windows Start 
menu. Typically, this is reached by clicking Start > Programs > HeavyMetal > 
HeavyMetal Map and click on HeavyMetal Map shortcut. If you chose a 
different start folder name during the install, use it to start the program. 
Note: You will also see several other shortcuts in the HeavyMetal Map folder, for 

viewing the Readme file or User’s Guide, going to the HeavyMetal web site 
or uninstalling the program. Use the same procedure outlined above to select 
a shortcut to another item. 

Starting using the Desktop Icon 
The HeavyMetal Map setup program also installs a shortcut icon on your 
Windows desktop, for quicker access to the program. Double-clicking on this 
icon will start the program in the same way as using the Start menu. 

Double-Clicking a Map Data File 
HeavyMetal Map data files have the file extension .HMX, which during the 
setup process is associated with the HeavyMetal Map program. Therefore, 
double-clicking on any map file with the HMX extension will automatically 
start HeavyMetal Map and load the map data file. 
Note: Due to the high amount of Windows resources and memory used when 

running HeavyMetal Map, you can only have one copy of the program 
running at one time. Therefore, double-clicking on another map data file after 
the program is already running will load that data file, but will not start 
another instance of HeavyMetal Map. 

Exiting HeavyMetal Map 
You may exit (quit) the program by clicking on the close button (identified by 
an X) at the far right of the program title bar, or choosing File > Exit from the 
program menu. You will be prompted to save your map if you have made 
changes since it was last saved or cleared. 
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Menu 

Palette Groups 
& Buttons

Map Design 
Area

Graphic Info 

The HeavyMetal Map main screen is divided into four major areas, each of 
which will be discussed separately. These are: 

Menu 
The menu, like with all Windows programs, provides access to many file, print 
and other functions. Pressing the Alt key and the underlined letter of any top 
level menu selection drops that menu down. The F10 key can be used in place of 
the Alt key if desired. 

Palette Groups and Buttons 
On the left is a cluster of buttons, some large than the others, from which will 
choose the various items you want to place on your map. 

Graphic Info 
On the right of the screen is a preview of the currently selected graphic, along 
with additional information concerning it. 

Map Design Area 
The largest portion of the screen, in the center, is the map design area. This is 
where you will place various graphics to “draw” your map, or view one that has 
already been designed. 

These areas will be discussed in more detail in the next section, Exploring the User 
Interface. 
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Exploring the User Interface  
Palette Groups and Buttons 

Graphic Groups  
All of the graphics in HeavyMetal Map are 
organized into groups. The reason for this will be 
explained later, but basically each group has 
common attributes and the groups are "painted" 
onto the map in a certain order. For example, 
Lakes always cover Terrain, so while you can 
paint grass or sand as a terrain on the map, you 
can be sure that when you draw a lake, it will 
cover them. For now, though, we'll just say that 
you choose which group of graphics you'd like to 
work with by pressing one of the larger buttons at 
the top. 

Actually, the top three buttons, Background, Add- 
On and Hex Info, are kind of special and work a 
bit differently, while the remaining nine group 
buttons have a common characteristic: clicking on 
one shows all the graphics available in that group 
on the graphics buttons below. 

In addition, along the top, the currently loaded 
Palette is displayed, along with a manual Refresh 
button. 

Graphics Buttons  
Once a graphic group has been chosen, all of the 
available graphics are shown on the buttons 
below, labeled Available Features, in the case of 
the Features group. If there are too many buttons 
and graphics to fit on your screen, the graphics 
buttons area will display a scrollbar to move to the 
one you want. Basically, to draw with a given 
graphic type, you click on the button with the 
graphic you want, and begin to draw. 

Hex Graphic Info 
Graphic Preview 

The Graphic Info area at the right of the screen 
displays information about the currently selected 
graphic (button). For example, if you choose the 
Light Woods, a graphic from the Feature group, 
the light woods graphic will be shown in the Hex 
Graphics Info area, along with information about the graphic type, including the 



 

description, text that will be placed in the text, height, special rules and other 
information, as applicable. 

Flip & Mirror Buttons 
One of the many great features of HeavyMetal Map is that many of the graphics 
can be flipped and/or mirrored to provide more variety, to look less rigid. You 
can choose which of the four flipped or mirrored graphics to use manually or 
you can even let the program automatically switch them, in a sequential or 
random manner. Drawing a truly random-looking forest was never easier! 

Other Options 
You can select to show the hex outline in the preview, or not, show the 
background color or pattern, or not, in the graphics preview. If you need lots of 
design area real estate, you can even hide the entire Hex Graphic Info area, and 
extend the width of the map design area. 

Map Design Area 
Map Window 

The largest portion of the HeavyMetal Map screen, located in the center, is the 
map design area. You can view the entire map at one time, while you are 
designing, or you can zoom in to see closer detail (more on that later). 

Graphics are placed by clicking with the left mouse button, or in the case of 
paths (such as roads and rivers), left-clicking once then dragging a rubber band 
line to the next hex location. As you move the mouse within the map design 
area, the hex number, elevation level, and if water exists, the water depth, will 
be displayed at the lower left corner of the screen in the format "Hex: 0515 L1 
D2". In addition, if you hover the mouse pointer over a hex, a popup tooltip will 
give you the same information in a slightly different format. 

Map Outline 
A black outline is displayed around the actual map sheet itself. A Classic 
BattleTech map sheet is 22" high by 18" wide, and contains 17 hexes vertically. 
The black outline corresponds to that part of the map. The outer, white border is 
provided to give more flexibility when drawing paths, in particular, and to help 
match adjacent maps. Nothing outside of the black outline will print or be saved 
as an image; only the actual map itself, within the outline, is printed or exported. 

Hex Numbers 
Hex numbering is automatic, and is shown on printed maps and images unless 
you elect to turn them off. But on the map design window, showing all the 
numbers would simply clutter things too much. So only the upper left number is 
shown for reference. Number usually starts at 0101, as on standard maps, but 
you can change the starting number to another number, as is sometimes done for 
two-map-sheet sets or other purposes. 
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Menu Tree Structure 
File ─┐ 
      ├─ Clear Map ─┐ 
      │             ├─ New Map (Default settings) 
      │             ├─ Clear Map (Same settings) 
      │             ├─ Clear Map (Keep borders) 
      │             └─ Clear Map (Invert borders) 
      ├─ Open... 
      ├─ Create Random Map... 
      ├─ Random with Last Settings 
      ├─ I'm Feeling Lucky!  ;-) 
      ├─ Save 
      ├─ Save As... 
      ├─ Save Map as Image... 
      ├─ Save Multi-Map as Image... 
      ├─ Print... 
      ├─ Most recently used files 
      └─ Exit 
Open (a duplicate of Open above, for quicker access) 
Edit ─────────┐ 
              ├─ Undo 
              ├─ Redo 
              ├─ Mirror Map Horizontally 
              ├─ Flip Map Vertically 
              └─ Rotate Map 180 degrees 
Preview ──────┐ 
              ├─ Full Map Preview 
              ├─ Upper Left Preview 
              ├─ Upper Right Preview 
              ├─ Lower Left Preview 
              └─ Lower Right Preview 
View Options ─┐ 
              ├─ Zoom... 
              ├─ Auto-Refresh 
              ├─ Auto-Refresh Delay... 
              ├─ Local Refresh 
              ├─ Show Background 
              ├─ Show Hexes 
              └─ Show Elevation Level Graphics 
Map Options ──┐ 
              ├─ Map Properties... 
              ├─ Change Map Palette... 
              └─ Palette Management... 
Help ─────────┐ 
              ├─ Tip of the Day 
              ├─ User’s Guide, PDF Format 
              ├─ Go to HeavyMetal Software Web Site 
              ├─ Check for Updates 
              ├─ Email Tech Support 
              └─ About HeavyMetal Map... 
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Using Shortcut and Function Keys 
Many of the menu selections have shortcut or function keys, so that you can 
more quickly access the functions you use most often. The following shortcuts 
are applicable to the HeavyMetal Map main screen: 

 Ctrl-N – Clear the screen and start a new map using program defaults. 
 Ctrl-C – Clear the screen but keep map settings the same. 
 Ctrl-O – Open a map data file. 
 Ctrl-R – Go to Random Map Creation screen. 
 F11 – Create another random map using last random settings. 
 F12 – Create a random map using the "I'm feeling lucky" method. 
 Ctrl-S – Save current map, overwriting existing map if already saved. 
 Ctrl-A – Save current map, while specifying a name and location 
 Ctrl-I – Save map as an Image, either in BMP or JPG format. 
 Ctrl-M – Save a multi-map combination (up to 4 maps) as image, in JPG 

format. 
 Ctrl-P – Go to the Print dialog box, from which you can print the map 

and data sheet. 
 Ctrl-Z – Undo, undoes the operations since the last time a graphic or 

group button was pressed. 
 Ctrl-Y – Redo, reverts back to the map design before the previous Undo. 
 F1 – View the User's Guide (this document); F1 is traditionally the 

way to invoke program help. 
 F4 – Full map preview at half resolution. 
 F5 – Upper left map preview at full resolution. 
 F6 – Upper right map preview at full resolution. 
 F7 – Lower left map preview at full resolution. 
 F8 – Lower right map preview at full resolution. 
 F9 – Go to and set Zoom properties. 

 

Other Main Screen Information 
Information Prompt 

Along the bottom of the main screen, and several other screens you will be using 
within HeavyMetal Map, you will find an informative prompt giving you 
context-sensitive information concerning the button or function you just pressed. 
Until you are familiar with all of the features of the program, keep an eye on this 
area for helpful information. 
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Time and Date 
No, there's no good reason for having this here, at the lower right of the main 
screen, but the room was there, and I thought it might help you keep track of the 
hours as they fly by while you're designing maps for that game this weekend.  ;-) 
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Getting Maps into HeavyMetal Map 

Loading and Viewing Maps 
Loading Existing Maps 

There are four ways to load an existing map: 

1. Select File, then Open from the main screen menu 
2. Select Open from the main screen menu. This is simply a repeat of the 

same menu object, and is just added to give a somewhat quicker method to 
access the Open screen. 

3. Use the hotkey combination Ctrl-O. 
4. When browsing, Double-click on a map data file. This starts HeavyMetal 

Map, if it is not already running, and loads that data file. 
Doing any of the above except number 4 will display the Open screen, from 
which you can preview saved maps and select the one you would like to open. 

Open Map File Screen 
The Open Map File Screen has several areas of interest: 

 

Default Folder / Last Used Folder Buttons 
The normal (default) location for saving maps when using HeavyMetal Map will 
be the \Maps folder within the folder into which you installed the program. 



 

Normally this will be c:\Program Files\HeavyMetal\HeavyMetal Map\Maps. 
Whenever you first view the Open screen after starting the program, it will be 
set to the Default Folder, and show files in the \Maps directory. 

You may also want to keep map data files in other folders, possibly a subfolder 
beneath the \Maps folder for custom designs, or even on a floppy or CD. The 
last folder other than the \Maps folder that you opened a file from will be saved 
by the program automatically whenever you open the file. You can then quickly 
navigate to that folder by clicking on the Last Used Folder button, and easily 
switch between the two by clicking one button or the other. 

Look In Folder Tree 
The folder tree labeled Look In shows the location of the selected folder on your 
computer. Use it to navigate to other folders or drives if desired, for opening 
maps saved in other locations. 

Select Map Listing 
The Select Map listing displays all the map data files located in the folder that is 
selected in the Look In folder tree. Only HeavyMetal Map data files will be 
displayed; other file types that happen to be there will not. 

Map Information 
As you select a map in the Select Map listing, information about that map will 
be displayed. You can use it, along with the map preview (below) to determine 
whether it is the one you want to open or not. 
Note: An important piece of information included with the map information is the 

palette that was used to create the map. Working with palettes will be 
discussed later in this guide, but suffice it to say that it is quicker to load a 
map in when the graphics used in it are already available; otherwise, the 
graphics must be loaded first, and then the map loading, extending the load 
time considerably. 

Map Preview 
The Map Preview provides a very low-resolution view of the map at the time 
that it was saved. This helps identify the map, and along with the map 
information (above) will make it easier to choose the one you want. Please note 
that the exact resolution of the map preview saved within the map file will 
depend on your resolution, map zoom and screen fonts at the time the map is 
saved; so previews of maps you’ve saved may differ somewhat from those 
included with the program. 
Note: Some graphics programs, such as ACDSee, are able to actually view the 

maps embedded into the HeavyMetal Map data files when browsing the 
folders containing the map. This is another way to view the maps prior to 
opening them. 
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Creating Maps 
Modifying Existing Map 

To design your own maps, it is often a good idea to simply load an existing map 
which is similar to the design you are interested in, and then add or change the 
graphics you would like to be different. You can easily add your own Add-On 
graphics, as well as normal map graphics, to any existing map. After loading a 
map, you will always have at least the same number of graphics that were used 
to create the map originally. If you have a more advanced palette already loaded, 
you will have more graphics to choose from (more on palettes later). 

Creating New Maps from Scratch 
You can also start from a clean screen, and design your map, literally, from the 
ground up. Doing so will involve a number of steps, a few of which will be 
listed here (and elaborated upon later in the guide): 

Clear the Screen 
To make sure you’re starting with a clean piece of map paper, choose File > 
Clear Map > New Map (Default settings) from the menu, or use the Ctrl-N 
shortcut key sequence. 

Choose a Palette 
Before starting, it’s best to make sure you have all the graphics available that 
you will need on the map. You can play it safe by loading the Advanced palette, 
as that will contain all graphics provided with the program. Or, if you have less 
memory or a slower computer, you may prefer to use the Basic palette. While 
they will be discussed later in detail, here are the three main palettes supplied 
with HeavyMetal Map, and their purpose: 

Basic Palette – The smallest and quickest-loading palette, it includes most all 
standard Classic BattleTech terrain types, but no buildings to speak of. You will 
be able to design maps similar to most of the basic published maps, such as 
Scattered Woods and Large Lakes with this palette. 

Intermediate Palette – The more advanced published maps, which often 
contain large multi-hex buildings and paved areas, have been designed using the 
Intermediate palette. It builds on the Basic palette, and over doubles the total 
number of graphics available, but also takes over twice as long to load and uses 
more memory. 

Advanced Palette – The Advanced palette contains many graphics that are 
extra, optional or, in Classic BattleTech, considered Level 3. Like the special 
terrain types listed in Maximum Tech such as magma and deep snow. It also 
includes buildings from CityTech and new special paths such as Railroads and 
MagLev/Monorails. These advanced terrain and feature types are not currently 
in use on any published maps, but are extremely interesting and fun to include 
and use. If you have sufficient memory, a fast machine and can wait an extra 15 
seconds or so when starting the program, you can use the Advanced palette all 
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the time. It also has the advantage of being able to load maps saved with the 
Basic and Intermediate palettes without any additional time to load graphics. 

Select a Background 
The background of the 
map, upon which all other 
features and graphics are 
drawn, can be a solid c
such as green or white, 
pattern or graphic whi
tiled across the entire m
area. You can even load in 
a map-size graphic of a 
finished, or partially 
finished, map and add
that, but the normal use 
will be to choose a pattern or texture that provides a pleasing background for 
other map graphics. You could choose a Sand background for a desert area,
brown background for barren ground or a grass/green background for a meadow 
area. 

To select a background, click on the Background group button at the upper left 
of the palette groups area, which brings up the Background Graphic Selection 
screen. The listing of background graphics are all stored in the \Backgrounds 
folder of the HeavyMetal Map installation folder. You can easily add your own 
backgrounds. Any graphic in that folder in BMP, GIF or JPG format can be used 
as a background, and will be tiled both horizontally and vertically to fill the 
entire map. (Note that the Background Preview scales the graphics to fit the 
space available, so should not be considered an exact representation of how it 
will look on the map. 

Note that you can also choose to use a plain (solid, non-patterned) background 
instead by clicking the Use plain color background checkbox and/or clicking the 
Set Background Color button and choosing a color. Whatever your choice, if 
you check the Use as Startup for new maps checkbox, the selected color or 
graphic will be used when first starting the program and when making New 
maps. 

Adding Graphics 
Although a more thorough description of the various graphics types will be 
discussed later in the guide, you don’t need to know all that to making or 
modifying your map. A good place to start is to click on the Features group 
button. After doing so, you will see that the sub-buttons below will change to 
display small graphics of all of the Feature types in the selected palette. Features 
will almost always contain important items like Light and Heavy Woods, Rough 
and Rubble graphics. Simply click on the graphic wanted, say the Light Woods, 
then click on the hex where you want to locate them on the map. You can click 
once on each hex to locate them individually, or “paint” many at a time by 



 

clicking and holding the mouse button down, while moving the mouse cursor 
through the hexes you want the graphic located. 

Flipping and Mirroring Graphics 
If you’re painting with a graphic such as the Light Woods, you may notice that 
the “woods” looks more like an orchard. That is, the trees are in rigid, identical, 
straight rows. While you may want this effect some of the time, you will more 
often want to have them appear more random, as is usually the case in nature. At 
the upper right of the screen, a large graphic preview of the selected graphic will 
be shown, and below it will be four buttons, with one to four of them having 
slightly modified versions of the same graphic. Basically, these represent the 
same graphic flipped vertically or mirrored horizontally, or both. You can click 
on the version of the graphic you want to use, and then place it on the map, or 
you can take advantage of an exclusive feature in HeavyMetal Map: you can let 
the program change the graphic for you, each time you place it, either 
sequentially or in a random pattern. Try it. Your woods will now appear much 
more natural, with no additional work on your part. 

Please note that there are times when the last thing you want would be to have 
the graphic flipping and mirroring on you automatically. When you place certain 
details on the map, such as river ends or bridges, you will want to specifically 
specify the orientation of the graphic. In these cases, it’s best to switch back to 
Manual selection, to have the control that you need. 

Graphic Groups and Layers 
At this point you may have found out that if you place a woods graphic on a hex, 
and then want to place another graphic on the same hex, that if they are both in 
the Feature group, only one can be in the hex at a time. You can’t place a Light 
Woods and a Rough graphic in the same hex, for example. While these two 
types of graphics are usually mutually exclusive (at least on all published maps), 
many others aren’t. You certainly would want a Bridge graphic in the same hex 
as the River it is meant to cross. And you might want Woods hexes over green 
grass terrain, in the middle of a barren brown background. 

To accomplish this, HeavyMetal Map uses Layers and Graphic Groups. While 
within any one group, only a single graphic can occupy a single hex, you can 
have up to one graphic from each group, all located in the same hex. This gives 
much more detail, flexibility of design and a generally better looking map than 
could be accomplished in any other way. So, select a different group button. 
Notice how each seems to have a particular order: Terrain is always underneath 
Features, for example. And Details always cover both Features and Terrain. 
Using this layered method provides a vast amount of creative control on your 
maps. Try it out and experiment. You’ll soon be getting the hang of it, without 
any long discussions (although you can read the long discussions later in this 
guide). 
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Lake Graphics 
Lakes are drawn similarly to any other terrain or graphic, except that a border, or 
bank, is automatically drawn around the outside only, giving it a more finished 
appearance which is slightly less hex-like and blends better with backgrounds 
and terrain graphics. In addition, you can choose a different lake depth, and 
“paint” with it, to vary the depth of lakes for depth 0 to depth 10. And if that’s 
not enough for you, there are ways of making them even deeper, by right-
clicking on a lake depth button, and changing the depth that that particular 
button represents. 

Drawing Paths 
There are three types of paths: Natural Paths, including rivers, and two levels of 
manmade paths, including roads and multi-hex buildings. This gives three levels 
of path graphics, allowing you to have a river, with a road crossing it on a 
bridge, with a railroad track crossing both on another bridge, all in a single hex. 
All due to the miracle of graphic levels. 

Paths are a special case in graphics, and in drawing them on a map. With the 
great variety of graphics required for various path combinations, they could be a 
nightmare to draw. To assist in this, HeavyMetal Map takes the 64 possible 
graphics required, condenses them into 23 separate graphics which can be 
flipped and/or mirrored, then decides which are required to draw each path. The 
bottom line is that you simply draw a line from A to B, intersecting with other 
paths if desired, and the program determines what graphics are required, and 
where to place them. 

To draw a path, first select the Graphic Path Group button (the Natural, Lower 
or Upper group buttons), then click and release the mouse button in the map hex 
where you want the path to start. As you then move the mouse, you will see a 
wide line rubber-band and jump to the nearest hex location that follows hex 
rows. As hexes are in rows at every 60 degrees, roads can only be drawn at 60 
degree angles, giving six possible angles. To complete the line, click again, and 
the rubber-band line will be replaced by the finished path graphics. To continue 
the road along the same or different angle, move the mouse again, with the 
rubber-band line, and click again on the ending hex for that road segment. 
Continue this as long as you like. 

To end one path and start a new one, right-click with the mouse. You can then 
begin drawing anew in a different location. Clicking another path or group 
button also ends the drawing of the current path or road. 

Solid Path / Pavement Areas 
Sometimes you will want a solid path or pavement area, without the “islands” or 
small unpaved areas in between. To totally eliminate them by using only paths, 
you first have to start with a path that is capable of it. Such paths include the 
Wide River (but not the standard one) and the Pavement or Tarmac paths (but 
not the standard road paths). These paths are wide enough to completely cover 
up to the hex side points, so work well in covering areas totally. To draw large 
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solid areas, crisscross the road or path across all three directions (vertically and 
diagonally to the right and left); doing so will result in a solid area, creating a 
large lake which is in effect a wider river, or a large paved area blending right 
out onto the normal width road. 

Hex Edge Walls 
Although the Manmade Paths includes a wall that goes through the center of the 
hex, like on many published maps such as the Military Base, Maximum Tech 
also gives rules for narrow walls along the sides of the hex. The Walls group 
button allows you to draw these, much like drawing lakes, only after you paint 
an area, the hex edge walls are drawn in place instead of lake banks. Notice that 
like lakes, hex edge walls can only occur along a completely enclosed area. 
However, you can add a Gate detail to provide access to the center of your 
walled area. 

Elevation Levels 
Drawing Elevation Levels is another special case. Start by clicking on the 
Levels group button, which show you the available graphics representing 
elevation levels, from a sublevel 10 to a level 10. As most level graphics look 
more like mountains, four additional levels, 1 though 4, are provided with a 
more grass-like appearance. To place any level, simply click on the level 
desired, and paint it in place. Placing one level over another one replaces it, so if 
you put a Level 4 graphic over a Level 2, the Level 4 will replace the Level 2 
graphic. Notice that as you draw, “cliffs” are placed anywhere levels are 
different, to help identify the perimeter of each level. 

Refreshing the Screen 
This is probably a good time to discuss refreshing the screen. As you add new 
graphics to the screen, or remove them, HeavyMetal Map keeps up pretty well 
in placing graphics. However, to speed things up, it cannot redraw the screen 
every time a single hex graphic is changed. And as some graphics overlap into 
adjacent hexes, it is possible to have an undesired appearance for a bit. This 
won’t appear on the final printed map or image, but only on the design map as 
you work on it. Unless turned off, the map will automatically refresh a few 
seconds after the last change was made. You have control over what this time 
delay is, and whether an automatic refresh will occur at all, with selections 
under the View Options menu. 

If you have a slower computer, or don't mind a few graphics "errors" while 
you're working, you can turn of Auto-Refresh entirely. You can then simply 
click on the Refresh button just below the menus whenever you want to update 
the screen. Local Refresh is another option, turned off by default, which redraws 
the neighboring hex graphics, in an attempt to keep them more "true" while you 
work. This can cause rather disturbing "ripples" around where you're working, 
and some people (like me) don't like it, while others use it all the time. You 
probably won't want to turn it on if you have a slow computer, though, as each 
time you draw a hex, it's actually drawing seven. 
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Clearing Hexes 
Like many things in the programs, there is more than one way to clear the 
graphics in hexes. When drawing most graphics, such as Features or Terrain, 
notice that at the upper left of all the graphic buttons is one marked "(Clear)", 
with no graphic. If you click on the Clear button instead of a graphic button, 
whenever you click on a hex, it will remove only that graphic type from the 
hex selected. That is, if you have Features selected, and click on a Light Woods, 
the woods graphic will be removed, but any Terrain or other graphic will still be 
there. 

No matter which group button is selected (a graphic group, not the Hex Info 
button, for example), even if you have a graphic button selected, you can press 
and hold the Shift key and click on a hex to remove, again, only that graphic 
type from the hex selected. Note that any graphic in that will be removed, not 
just the graphic currently selected. So if you have the Light Woods graphic 
button selected, and Shift-click on a Light Woods, it will be removed; but so 
also will be a Heavy Woods or Rough hex, as they are of the same group. 

Also when you have a graphic button selected, you can remove all graphics 
from a given hex (except for the background, which is part of the map, not the 
hex) by pressing and holding the Control (Ctrl) key and clicking on the hex. 

Identifying Hex Graphics 
While you are drawing a map, and in particular 
after loading a previously saved map, you may 
be confused about exactly what graphics are 
located in any given hex. To see that 
information, click on the Hex Info group 
button at the top of the group buttons. Doing so 
changes the button graphics area to the Hex 
Contents & Info area shown at the right. All of 
the graphics located in the hex selected (which 
is outlined in red when you click on it, and its 
hex number is shown on the screen as well) are 
listed in the Graphics in hex listing. 

As you click (select) any item in the list, 
information about that item is shown below. If it as a Construction Factor (CF), 
it will be shown, and the same for Height or Depth. Quite often you can change 
the CF, Depth or Height right at this screen. Keep in mind, however, that this 
only changes the value in that one hex, and if you want to change a number of 
hexes, you are often better off painting with them. 

Speaking of painting, at the bottom of this frame, the selected graphic's Group 
button and Hex graphic button are both shown. Clicking on the Group button 
takes you to that group, where you can paint with it or other graphics in the 
group. Clicking on the Hex graphic button immediately puts you into a Paint 
mode, as will be indicated by center button at the top of this frame (clicking the 
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button also puts you into Paint mode). In this way, you can find what graphic is 
in a particular hex, and then duplicate it by painting with it. 

Add-On Graphics 
So called because they are added on to the map, on top of every other type of 
graphic, Add-On graphics have a number of special features: For example, they 
can be of most any size, and can be resized, even stretched horizontally or 
vertically, and can cover many hexes, rather than just one. Good examples of 
Add-On graphics are the DropShip graphics included with HeavyMetal Map. 
You can select one, and locate it wherever you like on the map, even offset it by 
specified amounts from the hex center, and make it as large, or as small, as you 
like. 

 
When you add an Add-On, by pressing the Add button, the Add-On Graphic 
Selection screen (above) appears. When you select an Add-On graphic, located 
conveniently enough in the \Addons folder, a graphic preview of the Add-On, 
with its relationship to map hexes, is shown. Most Add-On graphics are larger 
than a single hex (although they don't have to be), so it is very important what 
size it is, and how many hexes it covers. In fact, when specifying or changing 
the size of an Add-On graphic, you can enter the size in Hexes or in Meters 
(based on the fact that a standard CBT hex is 30 meters across flats). You can 
enter your own title (description), and also, if desired, enter any movement and 
to-hit modifiers, CF and height, along with optional game rules. (Game rules 
only print on the Map Info Sheet, not on the map itself.) 

For more variety, you can also flip and/or mirror the Add-On graphic. Once 
you've selected the graphic desired, and set the size and other options as you 
want them, click OK, then left-click on the map to locate the Add-On graphic. If 
you don't like the location you've chosen, you can click on the Relocate button 
and select a new hex. Or, you can always select the Add-On graphic, the Shift-
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click to move it, or Ctrl-Click to clone it to another location. You can rapidly 
add many of the same Add-On graphic to a map this way. 

Other special feature of Add-On graphics is they aren't contained in the palettes; 
as long as the file is in your \Addons folder, you can add them, and of course 
you can add as many files to that folder as you want to. Add-Ons can also be 
placed over top of one another, if desired, for very complex composite graphics. 
The fact is that Add-Ons are among the exciting features that separate 
HeavyMetal Map from every other mapping program you've seen! 

Map Properties 
In addition to the graphics on a map, you also have control over what text 
appears in the hexes to mark terrain, depth elevation and features, as well as the 
size, color and type of text. This, and other options, are changed on the Map 
Properties screen, reached from the menu Map Options > Map Properties. 

 
Text in Hexes Tab 

As the screen above shows, you can specify the color and font type (solid, white 
with black outline or black with white outline), color and size. As you make 
changes in the text, the full size hex preview at the right shows what it will look 
like on the finished map. 

In some cases, you can also determine exactly what text, if any, appears in the 
hex. For example, for buildings you can choose to display the Class & Height, 
CF, Class & Height, Height Only, or nothing (good for Gamemasters who want 
to keep that information to themselves – it will still print on the map info sheet). 
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Title/Credits/Description Tab 
This tab provides a place to enter a Title 
for the map, Credits or Source and a 
Description (which only prints on the M
Info Sheet and not on the map itself)
Title and Credits are printed at the lower 
left of the final map, along with the CBT 
logo and program credits. You don't have
to enter this information, but it's good to 
identify your work, and take credit for it 
too, for that matter. 

Hex Outlines Tab 
You also have control over exactly how 
the hex lines, or outlines, are printed on 
the map. You can use solid lines (the norm), and specify their width, from very 
thin to very thick. Or, you can use various styles of thin dotted/dashed lines. Or 
eliminate lines altogether, the choice is yours. 

Level Graphics Tab 
This tab gives you very granular control on exactly how elevation level graphics 
are displayed. Your three choices are: 

Draw Terrain graphics over (and covering) Elevation Level graphics. This is 
best to be sure that terrain graphics are always visible, if they are on non-zero 
elevation levels. Like snowcaps on mountains. This is the default. 

Draw Elevation Level graphics over Terrain graphics. This more clearly denotes 
the elevation levels, at the cost of possibly covering some terrain. Best for quick 
recognition of elevation levels based on color and texture. 

No Elevation Level graphics. This option shows only the "cliffs" denoting 
elevation changes, and does not display any different color or graphic for each 
level. This is useful where the multi-colored elevation graphics might detract 
from the overall map appearance, or you want elevation levels to be more subtle, 
yet still marked. 

Saving Maps 
Be sure you've entered all the Map Information 

It's easy, when visually designing a map, to forget about the Map Title and 
Credits that will appear printed at the lower right of your map. Before saving, 
check this are of the Map Properties screen, either entering the text you would 
like on the map, or clearing unwanted text (as will be left from starting with 
another map when designing a new one). 



 

Save Your Map 
Maps are saved in the normal Windows way, by selecting on the menu File > 
Save or File > Save As. 

File > Save 
If the map you are working on has been previously saved, select File > Save, or 
using the shortcut Ctrl-S, will immediately save the design over the previously 
saved one. This is useful while working on a map, to periodically save, in case 
of a power outage or other problem. If you started a New map, then File > Save 
will take you to the Save As screen, where you can name your map and confirm 
the location to save it. 
Caution: Many a good file has been accidentally overwritten using the Save 

command. If you load a previously saved or standard map to use as a basis 
for a new map, but neglect to save it first with Save As, then Saving it will 
overwrite the original; probably not what you want. To prevent this, when 
using another map as a basis for a new one, immediately save the map with a 
new name, to prevent overwriting the original. 

File > Save As 
Save As allows you to save the current map, while specifying the filename and 
location to save the map (usually the \Maps folder). Save As works the same, 
whether you have previously saved the map before (in which case the current 
filename will be displayed as the default), or if it's a New design. 

Map Filenames 
Maps data files are saved using the normal Windows filename rules, and with 
the .HMX extension (indicating HeavyMetal heX Map). Allowable characters in 
filenames vary a bit from country to country, but in general, any letter, number 
and most type-able characters can be used except for the following: 
= * / : < > ? \ | 

Map Preview Image 
When saving a map, a small, preview image of the map design screen is created 
and saved within the map data file itself. This is done automatically, so you don't 
need to do anything for it to occur. This preview image is used to help identify 
the map when browsing files in the Open Map File screen, as explained and 
shown above. Keep this in mind when saving: although you can temporarily turn 
off elevation graphics, hex outlines and other features while working on the 
map, if they are turned off when saving, they will not be visible in the map 
preview. You may want to turn these features back on so the map looks most 
like the finished product. 

Also note that the actual size, in pixels, of the preview image will depend on 
your Window font settings, so previews you or others create may not quite 
match the appearance of those provided with the program. They will be 
stretched to fit the same area, however, so differences will normally be small. 

HeavyMetal Map User's Guide  Page 37 of 91 



 

HeavyMetal Map User's Guide  Page 38 of 91 

Printing Maps 

The Print Screen 

 
The print dialog box allows you to print maps of varying sizes to any Windows 
printers you have available (including printing to PDF if you have a PDF-
writing program such as pdf995 or Adobe Acrobat). You can also choose the 
size of the printed maps, resolution and other information. Options on this 
screen include: 

Printer Name 
Choose the printer you wish to print to here. You can also change the properties, 
such as sheet size or print quality, by pressing the Properties button. You can 
even set up printers that you don't actually have to print to a file, and then take 
or send the file to a location which has that printer, like a copy center or print 
shop. 

Print What 
There are two types of printouts that can be made: 

Map Sheets 
Obviously, the map sheets themselves are the main thing we're after with the 
program. Depending on the overall size of the finished map (standard CBT maps 
are usually 22" high by 18" wide), you will normally need to print more than 
one sheet, and tape or glue the sheets together. Anyhow, check Map Sheet(s) to 
print the map itself. 



 

Print Pages 
When more than one page is required for a map, you can choose to print all of 
the pages, or select individual pages to print. This is useful to see how a 
particular map will print, or to reprint only certain sheets for a map. 

Map Information Sheet 
The Map Information Sheet is a very useful tool, especially to the GM 
(Gamemaster). For all hex graphics that have movement or to-hit modifiers, 
Construction Factors, Heights or special Rules, this sheet will print a small 
graphic along with the description and other information about the graphic. The 
sheet also lists what hexes contain that graphic, so there is no doubt about which 
are which. Depending on the complexity of the map, this sheet can be several 
pages long, and is designed to be printed on 8 ½" x 11" or A4 paper. 

Map Size 
There are a number of options under the Map Size area: 

Standard CBT Size 
As mentioned above, a standard Classic BattleTech map sheet is 22" x 18". In 
order to print this size map on standard 8 ½" x 11" or A4 paper, six separate 
sheets are required. You can use larger size sheets to reduce the number of 
sheets required. 

Fit to 1 Sheet 
As this option says, selecting this option forces the entire map sheet to fit a 
single sheet of paper, whatever size paper is currently selected. Note that this 
should be in Portrait mode. Single sheet maps of the smaller sheet sizes are 
normally too small to actually use for play, but are excellent to record unit 
locations, have an easily viewed and filed record of your printed maps, PBM 
(Play BattleTech by Mail) or other uses. They just plain look cool! 

4" Hexes 
While not many of us have the equipment to play using 4" hexes, this is 
becoming more popular, so it is included. 4" hexes are actually in scale with the 
standard 1/285th scale CBT miniatures, so this gives a more true representation 
of speed and ranges than does a normal board. If you don't have access to a large 
format printer, however, you're in for a lot of cutting and pasting! 

Custom Size 
This selection allows you to choose any size map you like, by specifying the 
Height, Width or Hex Flat distance. Entering any one of them automatically 
calculates the other two. 

Single Upper-Left Full Size Sheet Only 
This option was added specifically for my son; he likes to use preprinted multi-
hex map sheets made by a print shop, with only hex outlines, numbers and a 
nice background, and then add 3D terrain and features using sheets printed by 
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HeavyMetal Map. Since to make this type of graphics, you don't need to print 
the entire sheet, but you also want to fit as much as possible onto a single sheet, 
this option simplifies that operation: It displays the largest area that can be 
printed on a single sheet of paper of the size your printer uses, which acts as a 
guide to where you can place graphics to be printed. You can then print out 
theses graphics, usually on cardstock, cut them out and glue the level graphics to 
¾" foam to make elevation levels, print other details as desired, and place those 
on the larger, plain map sheets. This makes a wonderful system, while using a 
minimum of ink and tape. 

 
To make graphics to be cut out and used on maps as described above, you will 
usually want to have a plain, white background, to minimize ink usage. 
Normally you will want to include hexes, to accurately place the pieces you are 
cutting out, and not include hex numbers, so that you can place the map sections 
wherever you like. The picture below shows the cutouts in use. 

 



 

Other Program Features 

Editing Maps 
The Edit menu has some pretty neat options to help you while designing maps: 

Undo / Redo 
A first for the HeavyMetal programs, HeavyMetal Map incorporates ten levels 
of Undo and Redo: 

Undo 
As you are designing your map, HeavyMetal Map is quietly saving your design 
every so often. Basically, every time you have made changes, and click on a 
new Group or Graphic button, the program saves your map. It also saves your 
map as soon as you load a new map, so if you start drawing, say, a multi-path 
building, and find out that it was a Lower path building, and just deleted a road 
you wanted to keep, you can Undo back to the point before you started drawing 
the building. The shortcut key for Undo is the standard Windows Ctrl-Z. 

Redo 
Any time you Undo, you can always Redo, to go back to where you were before 
you Un-, uh, Uh-did. So, if you add a group of features (remember, Undo 
undoes all of the items you've added since you selected a different group or 
graphic), you can Undo back to before you added them, then Redo to see them 
again, deciding which you want. You have up to ten levels or Redo, too, but as 
soon as you make a new change, you reset the Undo counter. As mentioned 
above, you can Undo up to ten times, and Redo all ten as well. 

Undo / Redo with Random Maps 
Random maps (discussed later in this guide) allow you to automatically and 
quickly create maps with randomly-located woods, water and elevation, 
according to parameters that you set. The Undo and Redo functions work with 
Random maps, as well, so you can create up to ten random maps, then Undo 
back to see the previous ones, using Redo to go forward again, examining them 
all to choose the one you like best. 

Other Edit Functions 
Mirror Map Horizontally 

Selecting this menu function mirrors the current map being designed 
horizontally. Hex graphics that were at the right border are now at the left, and 
vice versa. Use this feature to take a previously designed map, even a standard, 
published one, and dramatically alter its looks by reversing everything. It also 
has the advantage that maps that are mirror images of one another will always 
mate exactly at their side edges, making them very flexible to use. 
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After mirroring a map, you can also make any changes you like to the center 
area, leaving the side edges unchanged, to design a very different looking map 
that still has the advantage of mating perfectly with its companion maps. 

Flip Map Vertically 
Flipping the map vertically, is exactly the same as mirroring it horizontally, 
except the top and bottom are interchanged. Again, use this feature to make a 
map look different, while mating up exactly to other maps at the top and bottom 
edges. 

Rotate Map 180 Degrees 
Rotating a map 180 degrees is exactly the same as both Mirroring it 
Horizontally, and Flipping it Vertically, but you can do it in one easy step 
except two. This doesn't necessarily have the advantage of mating up with 
similar maps that the two above do, but it's good to change the looks of a map. 
Why don't you just flip the printed map around 180 degrees, you say? You can, 
of course, but rotating it within the program keeps the hex numbering and text 
direction consistent. 

View Options Expanded 
There are a number of options that affect your view of the map design screen 
that you can turn on or off while working with maps: 

Zoom 
Choosing View Options > Zoom displays the Zoom Settings panel: 

 



 

Although HeavyMetal Map usually scales the center map design area to fit the 
available space, and most find this the best way to design, running with lower 
resolutions, or just wanting to view parts of the map more closely during design 
make it nice to have other options. Here you can choose to scale the map in 
three ways: 

Show Whole Map 
This is the normal default mode when the program starts up, and allows you to 
view the entire map. 

Show Map Width 
If you have a smaller screen, hide the Map Graphic Info, or have a specially 
sized window, this selection often works out well. 

Manual Zoom 
You can control the size of the map hexes, basically control the zoom, using the 
slider. 

Hide Map Graphic Info 
If you want to maximize your view of the map design area, you can choose to 
hide the Map Graphic Info normally displayed at the right side of the screen. 
Useful especially with the Show Map Width selection above, this gives you a 
larger and closer view of a portion of the map (but not the entire map at once, 
normally). Please note that you will be missing some very useful information 
when in this mode, however: the Map Graphic Info not only shows you an 
enlarged view of what the graphic you have selected will look like, but it allows 
you to flip and mirror the graphic and change its CF or Height, in many cases. 
Still, it's easy to switch back, so choose to work however works best for you. 

Auto-Refresh 
For the best speed and response when drawing in HeavyMetal Map, usually only 
the hex you draw is being drawn; the hexes on the rest of the map don't change. 
This is usually fine, but sometimes a graphic being drawn can overlap a 
neighboring hex, temporarily creating a poor appearance at the edge. I say 
temporarily, as the large previews, printed maps and created images will never 
have these problems, only the design map. To help eliminate this, HeavyMetal 
Map includes an Auto-Refresh function. When checked, after you have 
completed drawing certain graphics and paths, the entire map is redrawn after a 
given number of seconds (selectable by you, below). This cleans up any display 
problems, and makes the map look better. But it takes a couple seconds or more 
to draw, depending on the map complexity and the speed of your computer. 
When using faster computers, you will probably want to keep Auto-Refresh 
turned on. With slower ones, you may want to turn it off. 
Note: When drawing paths (rivers, roads, multi-hex buildings, etc.), Auto-Refresh 

doesn't occur until you either right-click with the mouse (to end drawing of 
the current path), or click another group or graphic button. This prevents the 
program from interrupting you right in the middle of rubber-banding a path. 
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Auto-Refresh Delay 
You can control how many seconds the program delays after drawing the last 
graphic before it performs an Auto-Refresh. Again, for slower computers, you 
may want this either set to a longer time, or just turned off. For a fast computer, 
you can keep it set to only a couple seconds, and it works well. Or you may 
prefer a longer delay before it redraws, giving you more time to place graphics. 
The choice is yours. 

Local Refresh 
Some people like Local Refresh, and others don't. Basically, when painting, it 
redraws the graphics not only in the hex selected, but also in the six hexes 
around it. This can eliminate the need for an Auto-Refresh, as it eliminates a lot 
of the display problems that can occur. But it does slow things down (drawing 
seven hexes instead of one), and some don't like the "ripple effect" produced as 
surrounding hexes are redrawn. 

Show Background 
Background graphics look great on maps, and you will probably want to use 
them most of the time. However, busy background graphics can make details 
more difficult to see when designing. Therefore, you can Uncheck the Show 
Background to temporarily turn the background off, to see small details better 
during the design. The background color, if any, will then be the last selected 
solid color chosen. 

Note that this does not affect the Preview, Printing or creating Images; the 
Background will show there regardless of the Show Background setting, as long 
as you have selected a background for the map. 

Show Hexes 
This works a lot like the Show Background: it temporarily hides the hexes on 
the map design screen only. Hexes will still show up on Previews, Printing and 
created Images, as long as you've selected to have them visible. 

Show Elevation Level Graphics 
Similar to the two items directly above, this allows you to hide the Elevation 
Level graphics, and in their place, show Level numbers (normally 1 to 10 and -1 
to -10). Although the level graphics look great, it is often hard to tell, by color 
only, what level certain hexes are. Of course, you can move the mouse over the 
hexes to find out what level they are (in the popup Tooltip as well as at the 
lower left of the screen), but if you Uncheck Show Elevation Level Graphics, a 
number will be shown representing the level in each hex that has a level 
specified. This is often easier to see during design, although again, it does not 
affect Printing, Preview or Images. 

Random Map Designer 
For those who have difficulty coming up with an original map, or those who like 
the idea of a random, and therefore unbiased, map, the Random Map Designer 
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can save a lot of time, and be a lot of fun at the same time. You can reach it from 
the File menu at File > Random Map Designer or the Ctrl-R shortcut. 

Random Map Designer Screen 

 
Although the map is truly random in nature, you still have a lot to say about 
what is on it. You can determine the amount of the map covered with Light or 
Heavy Woods, Rough, Elevation Levels and Lake/Ocean areas. Just adjust the 
sliders to the desired percentages, and click Create to make your random map 
based on those percentages. Note that the total percentages of Woods, Rough 
and Water cannot exceed 100%, and likewise the total percentages of Elevation 
and Water cannot exceed 100%. If they do, then this will be shown at the bottom 
of the screen, and you will not be able to create your map. 

I'm Feeling Lucky!  ;-) 
An even quicker, and fun, way of producing a random map is by clicking on the 
"I'm Feeling Lucky!  ;-)" button. HeavyMetal Map then sets all of the above 
parameters for you, varying from map to map, and produces a truly random 
map. But, don't worry that you'll lose the percentages you spent so much time 
making for other maps; the I'm Feeling Lucky does not overwrite your settings; 
it just uses its own. In fact, your random settings are automatically saved from 
the last time you set them on this screen. 

Menu Shortcuts to Random Maps 
There are two menu selections on the File menu that give you random maps, 
without having to go to the Random Map Designer screen at all. 

File > Random with Last Settings 
Choose this from the menu, or pressing the F11 function key, will immediately 
make a random map with the same settings as last were set when making a 
random map from the Random Map Designer screen. Once you've got the 
settings where you like them, you can repeat making random maps as quickly as 
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you can hit the F11 key. And don't forget, you can use Undo and Redo to switch 
between them! 

File > I'm Feeling Lucky!  ;-) 
This selection, also available by pressing the F12 function key, will immediately 
make a random map using the I'm Feeling Lucky option. So you can quickly 
produce completely random maps, and decide among them by using Undo and 
Redo. 

Saving Images of Maps 
Printing maps is great, but sometimes you prefer to have an image. One you can 
view on a computer, or a large one that you can take to your local print shop to 
have printed. With HeavyMetal Map, you can produce images, in BMP or JPG 
format, sized however you like, up to and including full map resolution. In fact, 
you can make images of up to four maps at once, giving you flexibility 
unparalleled in map making programs. 

Save Map as Image 

 
File > Save Map as Image displays the above screen, where you can choose the 
image format (Window BMP or JPG), resolution and other options: 

Image Format 
Two image formats are available, each with its own advantages: 

Windows BMP format is a lossless format, that is, there are no compression 
errors or other problems associated with it. It also requires no additional 



 

memory to produce and save a BMP image, so may be the preferred choice for 
systems with less memory. However, only a single resolution is available, the 
low-resolution (1537 x 1888 pixels) full map, the same resolution as shown on 
the F4 Full Map Preview. If you choose BMP format, all other options will be 
set for you, except the filename. 

JPG (JPEG) format is a flexible with a number of options, and results in a 
high-color, compressed file. The JPG compression scheme is a "lossy" scheme 
that can create "artifacts", or small areas of color that really shouldn't be there. 
To help with this, the Quality of JPG files can be set, from 1 to 100, with 100 
being the highest quality (and largest file size), and 1 being the lowest quality 
(and lowest file size). The default in HeavyMetal Map is 25, but feel free to 
experiment and set it as you like. 
Note: Making JPG files uses quite a bit of memory, because the image is created 

separately and in addition to the preview images. A full-resolution map 
requires approximately 100 MB of memory in addition to the memory used 
by the program. (A low-resolution map uses about 50 MB.) If you do not 
have sufficient memory, Windows will swap memory out to virtual memory, 
which is additional space located on your hard drive. This can slow image 
creation greatly, so be sure of your available memory before creating such 
images. 

Image Size 
Other options with JPG include high- and low-resolution (high is the same as the 
F5 to F8 previews, and is double that of low-resolution), or you can set any 
image size you like (1537 x 1888 or below). This is useful for making smaller 
screens to post on a web site, or other use where very high resolution is not 
required. 

Filename 
The default filename will be the name the map was last saved with, with either a 
BMP or JPG extension. You can change the filename as desired, as well as the 
location it will be saved to (which defaults to the \Images folder of your 
HeavyMetal Map installation folder). You can also Browse to a new location, 
even make a new directory from the Browse menu, if desired. 

Save Multi-Map as Image 
One of the exclusive features of HeavyMetal Map is the ability to combine up to 
four standard map sheets, and make a multi-map image of all of them. To help 
with this operation, a special screen is provided, from which you select and add 
the maps you want to use. 
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Save Multi-Map Image as JPG Screen 

 
Memory Use for Multi-Map Images 

As mentioned above for single maps, making JPG images uses a lot of memory. 
It follows, then, that making JPG images of up to four maps uses an awful lot of 
memory! At a memory use of approximately 100 MB per hi-res map sheet, a 
four-map image uses approximately 400 MB of additional memory (above what 
is normally used by the program). Low-res images use about 50 MB per map 
sheet. Since memory is so important to this operation, the upper left of the 
Multi-Map Image screen shows the estimated required memory, as well as the 
actual Available memory (not counting any virtual memory on your hard drive). 
Note: Due to the large amount of memory usage, and the fact that different versions 

of Windows handle such memory differently, we cannot guarantee operation 
of making JPG images on all computers. Most should be able to make them; 
some will not. Use the feature if you are able, and drop back to BMP single 
map images if you cannot. 

Folder Buttons 
As with the Open Map screen, you have a choice of browsing for maps to make 
images of in the standard \Maps folder, or an alternate location used previously, 
or you can browse to any desired location on your computer. 



 

Select Map and Map Preview 
Choose the map you would like to add to the multi-map image from the Select 
Map files shown. The files shown are determined by the folder buttons and Look 
In folder tree listing. Only HeavyMetal Map HMX files will be displayed. As 
you select a map data file in the listing, a small preview will be displayed to help 
identify the map you want. 

Image Options 
As with single map images, you have the choice of high- or low-resolution 
images, and you can also choose the JPG quality, from 1 (lowest quality, 
smallest file size) to 100 (highest quality, largest file size). As noted above, low-
res maps use about 50 MB per map, while high-res maps use about 100 MB per 
map. 

Filename 
The default filename is MultiImage.jpg, and the default save folder is the 
\Images folder in your HeavyMetal Map installation folder. Feel free to change 
the name to a unique name (you will be warned before overwriting a previously 
saved image) and different folder, using the Browse button and/or typing in a 
different filename. 

Adding Maps 
After you have chosen the map you want, and have confirmed it is the one you 
think it is, you can Add it to any of the four map locations by clicking the Add 
button on the map location where you want it to be. Continue this process to add 
up to four maps to your multi-image. Clicking Add on a location that already 
has a map simply replaces the current map with the one selected. 

Removing Maps 
Although you can change the map selected at any of the four positions simply by 
Adding another one to that location, you may sometimes want to remove the 
map from a location entirely. To do so, simply click on the Remove button to 
remove it. 
Note: It was stated above that the memory used is dependent on the number of map 

sheets used in creation of the multi-image. Actually, it is dependent on the 
total rectangular area. So, a 3-map multi-image will take the same memory as 
a 4-map multi-image. You may still want to leave one map blank, but don't 
do so just to save memory, as it won't. 

Flipping and Mirroring Maps 
A truly unique feature in making multi-maps with HeavyMetal Map is that you 
can actually flip and/or mirror any or all of the selected maps. This gives you 
variety in the individual maps as well as in combining them. You can take any 
single map, for example, select it at all four locations, and flip and mirror them 
to create a perfectly matching 4-map set. 
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Hex Numbering Multi-Maps 
Individual maps have a starting hex number, for the upper left hex of the map, 
which normally starts at 0101, as with published maps. This can be changed 
with any individual map, if desired, when it is saved. When creating multi-maps, 
you might often load four maps that have the same starting hex number, and that 
can be confusing. So – HeavyMetal Map to the rescue: You have the option of 
making the number of up to four maps Continuous, meaning it starts with 0101 
at the upper left, but does not restart the numbering system on the other maps; 
they are all numbered in sequence, so that no hex number is repeated. In 
Normal mode, the hex numbers retain the order that the map was saved in. In 
All 0101 mode, each map is renumbered beginning at 0101, meaning you'll have 
the same numbers occurring on all four maps. 
Note: One thing that makes the Continuous numbering method even more special is 

that it adapts for any maps that have been flipped and/or mirrored. Normally, 
flipping or mirroring an image would change the hex locations, maybe even 
make the numbers upside down or backwards. HeavyMetal Map 
automatically renumbers the hexes so that they are all facing the same 
direction and still continuous. 
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Working with Graphic Layers 

What is a Graphic Layer? 
Graphic Layer Definition 

In HeavyMetal Map, a Graphic Layer is a group of graphics, available when 
selecting the Group graphics button, and whose graphics are drawn together 
when the program makes printed maps and images, even the map design screen. 
The exact graphics which are available in each layer depend on the palette being 
used. 

Drawing Order 
All graphics from one group are drawn before those in the next group are 
started. For example, all Terrain graphics are drawn for the entire map, before 
and Feature graphics are drawn, so that all Features always cover, or overlap, all 
Terrain. Likewise, all Features are drawn for the entire map, before any Detail 
graphics are drawn, so they will always overlap the Features. This is a very 
important concept in HeavyMetal Map, especially so if you are designing or 
modifying your own palettes, because it helps determine where you place any 
additional graphics. 

Within any given group, the graphics are drawn in Reverse order. That is, the 
first graphics in the list will be drawn over top of those later in the list. 
Normally, this makes little if any difference, but should be considered when 
designing your own palettes and placing graphics within the group listing. 

About Graphic Layers 
Graphic layers allow HeavyMetal Map to display many different graphics in the 
same hex, one over the other, in a defined order, to make it easier to create 
quality, and if desired, complex maps. You don't really need to know about 
layers; you can just design your maps without worrying about such things. But 
for those of you who like to know how things work, I'll elaborate on how the 
Layers work, what goes in them and the order in which in they are drawn. 

Listing All Layers 
The following is a list of each layer and what it does. In general, the layers are 
drawn the order given, so the second layer can cover part of the first, the third 
covers the second and first, and son on. 

Background  
The Background layer is drawn first, before 
anything else is drawn. And unlike all other layers, 
it is repeated (tiled) both horizontally and vertically 
until it covers the entire map screen. It always 
begins at the upper left corner of the actual map 
(and therefore does not cover the white, non-
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printed borders which are displayed on the map design screen). Normally, the 
background is a grass or ground graphic, and can be detailed or just mottled, and 
serves as the backdrop for all the detail on the map. A highly detailed, and dark, 
background can be visually appealing, but it can also tend to make map details 
such as Woods and Buildings more difficult to recognize. Therefore, a selection 
of Backgrounds is included with HeavyMetal Map that ranges from light to 
dark, detailed to blurry. The choice is yours. Another great thing about 
backgrounds is they can be changed at any time, or added later, without 
affecting anything else on the map. So you can decide later what background 
looks best with the detail of your map. 

The background doesn't have to be an image or pattern; you can choose a solid 
color as your background, or even white (to minimize ink usage). 

Elevation Levels  
Elevation levels are shown by "cliffs", denoting a 
change in elevation from one hex to the other, and 
an optional graphic to indicate the elevation. By 
default, the graphic for the elevation hex is drawn 
in this order, over the Background graphic, and 
under any Terrain graphic, such as snow. This 
makes it easy to have snow-capped mountains and 
still show hex elevation graphics where they are not covered by snow. If you 
prefer to have the Elevation hex graphics cover any terrain you've selected, you 
can choose this option on the Level Graphics tab of the Map Properties screen. 
You can also choose to not show the hex level graphics at all, but only draw the 
"cliffs" denoting elevation changes, on the finished map, by selecting this on the 
same tab and screen. 

Elevation levels add a lot to most maps, giving a more varied and more 
interesting background, and helping to visually separate areas of different 
elevations. The graphics provided for elevations generally depict mountains or 
barren terrain, but you can choose to use the grass-like elevations provided for 
levels 1-4 on maps such as Rolling Hills, where barren terrain is not appropriate. 
Again, you can change the elevation that any given graphic represents, so you 
have a lot of possibilities here. 

Note: While the hex Elevation graphics themselves are drawn here, either before 
or after Terrain graphics, the "cliffs" are actually drawn later, so that elevation 
level changes are clearer. 

Terrain 
The next layer to be drawn is the Terrain layer, graphics 
that cover entire hexes or groups of hexes. Examples of 
Terrain graphics include Pavement and Deep Snow. 
Sometimes Terrain is for decoration only (like grass 
terrain on a brown background), while other times there 
are rules associated with them, like the movement modifiers applicable to sand. 
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Such movement modifiers do not print on the map sheet itself, but do appear on 
the Map Info Sheet. By default, Terrain graphics cover Elevation graphics, but 
as mentioned above, the order can be reversed from the Level Graphics tab of 
the Map Properties screen. 

If the included Elevation levels are not high or low enough to suit your map, you 
can redefine what the elevation level of any elevation graphic represents, as 
described later in Advanced Operations. 

Note that Terrain graphics often overlap the hex outline itself. This is done to 
provide a more irregular (less hex-shaped) area for the terrain, while still giving 
a continuous appearance for multi-hex terrain areas. 

Lakes 
Lakes and other multi-hex water areas, which 
include oceans, seas and shoreline, are drawn over 
the above graphics. Similar to Elevations, Lakes 
are actually composed of two separate types of 
graphics: The Lake graphic itself, which varies 
with depth, and the "Lake Bank", which provides a 
pleasing edging around lakes, between them and 
land areas. 

Ten depths of Lake/water graphics are provided with the program, however, like 
Elevation graphics, you can redefine what the depth that any water graphic 
represents, as described later in Advanced Operations. 

Natural Paths  
Natural paths, drawn next in the drawing process, 
are most commonly used to draw Rivers, and two 
widths of rivers are provided with even the Basic 
palette. It can also include other types of natural 
paths, or even manmade paths. Why include 
manmade paths here, you ask? To include 
additional flexibility, for multiple building levels or 
other special occasions. Basically, this gives a third 
path layer, and that really comes in handy some 
times. 

As noted earlier in the description on drawing paths, Natural Paths are drawn 
differently than hex graphics. You place the desired path by rubber-banding a 
thick line, and the program places the required hex graphics to draw what you've 
indicated. The River graphic, being drawn over the Lake graphic, allows the 
river to flow over the "banks" of the river, providing a natural and pleasing 
appearance. 

 



 

Features 
The mainstay of maps in HeavyMetal Map is the 
Feature. This very flexible map graphic includes 
such standard map objects as Light and Heavy 
Woods, single hex buildings such as Domes, Rough 
and Rubble hexes, Bridges and much more. The 
Intermediate palette, for example, even includes 
airport Runway graphics, along with ends and 
crossings for the runway. Many of these graphics require a Height and/or 
Construction Factor (CF) to describe. Woods, for example, have a Height, while 
buildings have both a CF and a height. Normally, the CF appears in the hex with 
the building, although you have control over exactly what appears, so if as a GM 
you want to hide the CF (or even the Height), you can. It will then show only on 
the Map Info Sheet. 

Flipping and Mirroring graphics becomes very important with Features. Large 
forests composed of Heavy Woods, for example, look much more natural if they 
aren't composed of identical graphics. Flip and mirror the woods and you have a 
much more pleasing forest. You can do this manually, having complete control 
over exactly which way the graphic is flipped or mirrored, but you can save a lot 
of time and get a very pleasing effect by using the Random or Sequential buttons 
below the Hex Graphic Info area at the right of the main screen. Even if you 
prefer a specific flip/mirror combination for a given hex while placing them 
Sequentially, you can simply click again a time or two to get the effect you're 
looking for. 

Lower and Upper Paths 
Lower and Upper Paths contain mostly 
manmade graphics, such as Roads and other 
Paved areas, Railroads (including MagLev or 
Monorails), as well as multi-hex buildings. 
Roads are easiest to understand, and are 
quickest to draw. You draw them in rubber-
band mode, from one hex to another, laying 
only a straight section between the two hexes. 
The rubber-band line shows you where you 
can draw to. To make curves, simply continue drawing to other hexes at an 
angle to the original line; roads will be connected with curves and intersections 
as necessary. 

Why both Lower and Upper Paths, when in fact the graphics in both are 
identical. Again, the reason is flexibility. By having both a Lower and Upper 
path, one can go over the other (you cannot have two different paths in the same 
hex at the same level). The map section shown to the right shows a Railroad 
added as an Upper Path going over a Road added as a Lower Path. For 
reference, the bridges shown are actually Details (to be discussed next), as they 
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go over all paths; a Bridge added as a Feature would be under the paths in this 
picture. 

Multi-Hex Buildings and Paths 
Multi-hex buildings and paths are a special type of path; they can be drawn in 
exactly like roads and other paths, but you will usually want to have larger areas 
completely covered, with no edges of the building drawn. In order to allow you 
to have roads and other paths running parallel to one another in adjacent hexes, 
the program cannot automatically fill in solid areas for you; you have to go back 
and crisscross them with additional paths to do so. Here, for example, are two 
pictures of a multi-hex building, the first time done only with outline and 
vertical paths. It is probably not what you're looking for (but could be).  

   
 Step 1 Step 2 Step 3 

The center image shows the extra paths required to "fill in" the building, and use 
only the outline edging. The image at the right shows the final building that 
results from adding the extra paths. The extra time is worth it, I think. Also note 
that this same technique of going back and crisscrossing the same paths makes 
the best large paved areas, using the Paving or Tarmac graphics. Also note that 
this technique only works well with the wider paths, such as the Wide River and 
Canals (in the Natural Paths), and the Paving, Tarmac and Buildings (in all 
paths). Thinner paths, such as the normal River and Roads, are narrower than the 
hex edges, so cannot be made into a continuous, solid area. They do have the 
advantage of making more detailed and accurate intersections of those paths, 
however. 

Details
Details are much like many other graphic types, with the main difference being 
that they are drawn on top of almost all other graphics. For example, if you want 
to have a Road go into (under) a stone tower, you should place that tower as a 
Detail and not as a Feature (because Road paths go over Features, but under 
Details. Details also add, uh, detail (duh!) to other paths and buildings. For 
example, you can add railroad crossing details over road and railroads, building 
details such as exhaust fans or HVAC (Heating, Ventilating and Air 
Conditioning) equipment on top of multi-hex buildings, Heliport markings on 



 

HeavyMetal Map User's Guide  Page 56 of 91 

Tarmac or buildings, etc. You can also add more variety to multi-hex buildings 
by adding the acute pointed building details over the chopped-off building paths. 
They don't need to have a CF or height in of themselves, as the building hex 
under them contains that information. 

You'll also find map details such as Fire, pointy river ends (the standard path 
river end is designed to end into and overlap the lake graphics), Bridges and 
other items. And as mentioned earlier, you'll also find some graphics here that 
are also located in Features. For example, round domes, so they can be used as a 
building themselves, or added as an architectural component to a large building. 
Again, flexibility is the key: the additional layers, and yes, a certain amount of 
additional complexity, gives you the ability to add so much more to your maps; 
more than in any published map, in fact. 

The illustration to the right will be used to 
show both Details and Hex-Edge Walls 
(further described below). In this case, the 
AA and large turret guns, as well as the 
liquid tanks and even the bomb damage, 
are done as Details.  

Walls (Hex-Edge) 
Hex-Edge walls are different than normal 
walls centered in the hexes and drawn as 
Lower or Upper Paths. According to the 
rules in Maximum Tech, these walls follow 
the hex outline itself, and therefore can 
contain other structures and graphics, while 
normal path-type walls usually are the structure. These walls are actually drawn 
in two steps, when drawing the graphics. The filled-in area of the wall (within 
the wall outline) can be paved, concrete with expansion joints, or more natural 
choices, or can be eliminated entirely. These graphics are actually drawn over 
the Background, Terrain and Lake graphic layers, but under Paths and higher 
graphics. In this way, you can delineate the forts and other walled areas, yet still 
show all the detail you like within them. 

The hex-edge Walls themselves are drawn over most other graphics, but under 
Details. Again, this gives a lot of flexibility, and you can have very pleasant 
combinations of graphics against one another and even in the same hex. While 
there is no way to have a non-continuous wall area (that is, have a break in a 
wall), you can add small "gates" as a detail, located in the Details group, over 
the walls. This gives a good-looking man or vehicle gate or door for use with 
them. 
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Elevation Levels 
One of the most important features on any 
Classic BattleTech map is elevation levels, and 
HeavyMetal Map gives you a choice of ways to 
show them. As described earlier in this Guide, 
you can choose both positive Levels, and 
negative Sublevels, with some alternate 
graphics for the lower levels. And, they are a 
special graphic, when it comes to drawing them 
on the map. They really don't quite fit in with 
the Layer concept of HeavyMetal Map, but 
actually distribute themselves through the layers 
somewhat. Therefore, they are discussed here separately, as they are listed at the 
end of the layer buttons. 

Sometimes on a map, the Elevation level is of primary importance, and you 
want to show the graphic selected for the elevation over top of any terrain 
within, but usually the terrain itself is important. Therefore, despite the fact that 
Elevation Levels are discussed at this point in the Layer structure of HeavyMetal 
Map, the hex graphics for them are usually drawn under Terrain graphics. In this 
way, you can have a snow-capped mountain, for example. You can, from the 
Map Properties screen, choose to draw Elevation graphics over Terrain graphics, 
but that is up to you. In fact, you can choose to not use any Elevation graphics, 
but rather draw only the "cliffs" that occur where elevation changes take place. 

The Cliffs themselves, however, are drawn later in the drawing process, always 
over any Terrain, but under the remaining graphics. This is so that Rivers and 
Roads can be shown continuing down a slope, etc. The picture shown above 
shows several Elevation level graphics (1 through 3, in this case) along with a 
River running down the small mountain. To add interest, two Waterfalls have 
been added where the elevations change, and Rapids have been added as well, 
both found under the Detail graphics. 

You will notice that some graphics are duplicated in more than one group, or 
layer. For example, you will find Bridges in both Features and Details. This 
gives a lot of flexibility, because the main thing in grouping graphics into layers 
is not exactly what is in them; it's what you want to show on top of other 
graphics. Whether a bridge, for example, should go over some graphics, such as 
Railroads, yet under other graphics, such as Roads. Having duplicates of certain 
graphics helps provide this flexibility. 
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Add-On Graphics 
Add-On graphics, as selected from the 
separate Add-On Graphics Screen 
described earlier in this guide, are the last 
graphic of any kind to be drawn on any 
map. That is, they cover all other graphics 
on the map. Whether it's Rivers or 
Buildings, Details or Deep Snow, the 
DropShip add-on graphic will always 
cover them all. In fact, there are only two 
things that add-on graphics don't 
necessarily cover: other Add-On graphics 
(they're drawn in the order shown in the 
list, so lower ones can overlap or cover 
earlier ones) and the hex lines and text 
itself. Therefore, Add-On graphics are 
great for showing large multi-hex 
DropShips, or even buildings, large Craters and many other items. 

An additional advantage of Add-On graphics is that there is no limitation on 
how many can be in a single hex. Meaning, in particular, that they can cover one 
another. In the picture above, an Overlord DropShip has been placed as an Add-
On, alongside a Habitat sporting a Kurita emblem, both Add-Ons. The 
combinations are endless. The main thing, as always, is to get the flexibility you 
need and want to put most any idea you have for a map into images and 
printouts with HeavyMetal Map 
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Using Graphic Layers to Make Better Maps 
As the graphics and descriptions of all of the layers above shows, using graphic 
layers provides much more flexibility, and control, than would otherwise be 
available. Let's show a couple simple examples of how best to use them. 

Combining Roads, Rivers and Bridges  
An Example of Layers 

One of the most common uses for the graphic layers within HeavyMetal Map is 
to have a logical and pleasing combination of roads, rivers and bridges on a 
map. All roads and other manmade paths will normally cover, or go over, rivers. 
It is important to realize that the different layers come in handy not just when 
you want the various graphic types in the same hex, which occurs less often, but 
rather for ease of working with them all over the map. In the example given 
here, all occur within the same hex. But they would stay on the same level 
throughout the map, establishing easy and consistent graphics all over. 

The diagram at the left below shows a single hex, with a green background, and 
above it, in the order drawn or placed, are a portion of a River path, then a 
Bridge from the Features group, a Road from the Lower Paths, a Railroad track 
from the Upper Paths, and finally a Truss Bridge from the Details group. 

 
The result of placing these graphics in a single hex is the hex graphic shown 
above at the right (along with a bit of the neighboring hex graphics). It's 
crowded, in this example, but you can see the flexibility that these layers give 
you. With paths continuing and crisscrossing the map, you can make a very 
complex yet useful and attractive map. 
Note: The hex outlines shown on each would not normally be there, but would 

rather be drawn by the program after all the graphics are on. The outlines are 
only shown here to help illustrate the location of the various graphics in 
relation to the hex outlines.) 
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Combining Multi-Hex Buildings 
Another of the great uses of having multiple Path layers is when constructing 
large, multi-hex buildings. It is so useful, in fact, that we "cheated" just a bit by 
placing another multi-hex building path in the Natural group, usually reserved 
for rivers and other natural paths. This gives us the possibility of having up to 
three separate multi-hex building paths in a single hex. Let's make one to see 
how it works out: 

Multi-Hex, Multi-Level Building Example 
I think you understand how the levels each cover one another, so I won't draw 
another with separate levels. For this example, let's draw our large and complex 
building a step at a time: 

    
 Step 1 Step 2 

   
 Step 3 Step 4 

It is often best to start out with the lowest level of the building and establish its 
shape, so let's do that. For that, I selected the gray-roofed building path in the 
Advanced palette, and used the default 2 levels height and a CF of 40. I want a 
fairly fancy shape, here, so have drawn the outline accordingly. Next, I selected 
a Lower Path building with a red roof, and set the CF to be the same (40 CF for 
a Medium building), but changed the Height to 4, and drew in the red section in 
the second picture. Then, I selected the Upper Path, and chose a building with a 
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tan color roof, set it again to 40 CF but upped the height to 6, and drew it in as 
shown. Finally, I added a round Skylight from the Advanced palette Details 
group, showed the building information, a voila! A finished, multi-hex building. 
Note: When more than one path layer is used in a single hex, only the text for the 

highest height and highest CF are displayed. 

More Complex Examples 
Sometimes, even with the flexibility that HeavyMetal Map provides, it may not 
be immediately apparent how to draw certain complex maps. For example, what 
if you want a road crossing your map, going over another road, and in another 
part of the map, going under a railroad. With only two Paths with roads, and 
with this example appearing as if it needs three, it seems like there's a problem. 
Hover, it is possible to make one path, or road, be a Lower path in one portion of 
the map, and an Upper path in another, yet seem to be a single path. 

It is not possible to actually join a lower and upper path, but you can end them at 
exactly the same point, to have the appear joined. Let's work out an example, a 
map with a vertical Road at the left drawn with a Lower path, and a vertical 
Railroad at the right drawn with an Upper path, giving us the first picture below: 

  
 Step 1 Step 2 

  
 Step 3 Step 4 

Next, a Highway path is drawn as a Upper path starting from the left and 
crossing the road below it. In this case, I've curved it toward the bottom of the 
screen before ending it (which automatically ends in a cul-de-sac). Also, a 
Highway path is drawn as a Lower path starting from the right and crossing 
under the railroad, meeting with but continuing one hex beyond the other 
highway. 

Now, we need to get rid of the overlapped areas. Which selecting the Lower 
path highway, either click on the Clear button, or press the Shift key and click 
on the cul-de-sac portion of the path that you don't want; it disappears. Select the 
Upper path group button, and in the same manner, remove the unwanted cul-de-
sac on it. Now the both the Upper and Lower Highway paths meet at the same 



 

point, the hex edge, giving the appearance of a continuous highway. I've added a 
Detail truss bridge for the Highway and a Bridge for the Railroad, and the path 
is done, giving a realistic appearance. 

Use Your Imagination 
While some of the examples might seem complex, they are just a drop in the 
bucket when it comes to the tools and techniques you have available when 
designing maps with HeavyMetal Map. Using your imagination to come up with 
your own original map designs will result in fun and, no doubt, the admiration of 
others when displaying your work! 
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Working with Palettes 

Understanding Palettes 
You've heard the word used during this guide, again and again, without a real 
definition. My dictionary gives the following definitions: 

A thin and usually oval or oblong board or tablet with a thumb hole at one end, 
used by painters for holding and mixing colors. 

The set of colors on such a board or surface. 

The range of colors used by a particular artist. 

The elements of any art considered as to quality or range. 

HeavyMetal Map Palettes 
In HeavyMetal Map, a palette is a group of graphics, usually at least some 
graphics in each of the groups or layers that the program uses (and which were 
described in detail earlier in this guide). When you load HeavyMetal Map, a 
palette, all the groups of graphics, are loaded so as to be immediately ready for 
you to draw using them. So, the palette includes the Terrain, Lake, Natural and 
Man-Made Paths, Details, Walls and Elevation graphics that are selected by the 
Group and individual graphics buttons. The palette does not include the 
Background or Add-On graphics; those are loaded independently from the 
palette graphics. 

Changing Palettes 
There are two methods for c
the palette in use: 

hanging 

hange 
ou 

 

g 

to 

Change Palette Screen 
The Choose Palette screen is 
reached from the main screen 
menu, using Map Options > C
Map Palette. Using this screen, y
can change the palette in use before
designing a new map, or even 
change it in the middle of designin
a map. Normally, changing the palette after you've started a map should be 
avoided, because the new palette may not contain graphics that are the same, or 
in the same location as, the current palette. However, changing from the Basic 
Intermediate to Advanced palettes is fine, as they are progressive, or build on 
the lower palettes (this will be discussed below). You can choose from the three 
Standard palettes included with HeavyMetal Map, or from custom palettes 
which you have made or modified. 

You can also choose to use the selected palette as the default, startup palette 
when HeavyMetal Map first starts, by checking the box indicated. (The "Reload 
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Graphics" option is useful when graphics are changed, and you want them to be 
reloaded from scratch, but is normally not required.) If you have already started 
your map, you will be warned that loading a different palette can cause a 
problem if the included graphics are different, or those already used are not in 
the new palette, but you can continue anyway. 

Loading Maps 
When you load a different map, if it requires a palette other than the one 
currently loaded, it will be loaded automatically, during the process of loading 
the new map. 

Palette Types 
Standalone Palettes 

A standalone palette contains all of the palette graphics required for a map. It 
does not depend on any other graphics being loaded. 

Palettes that Build On Other Palettes 
The Standard Palettes included in HeavyMetal Map are incremental; the 
Intermediate palette "builds on" the graphics loaded by the Basic palette, and the 
Advanced palette builds on them both. Why do it this way? There are a number 
of reasons:  

Better for Older PCs 
Some slower systems with less memory may have problems loading all of the 
advanced graphics included with HeavyMetal Map. In this case, the Basic 
palette provides most of the graphics required for producing or modifying the 
standard, published maps. Basically (pun intended), you get a lot of functionality 
for your memory buck with it. (Newer systems can usually make use of the 
more advanced and numerous graphics.) 

Quicker Palette Loading 
If the Basic palette is already loaded, then when loading the Intermediate palette, 
only the additional graphics it requires over and above those included with the 
Basic palette needs loading. This about halves the loading time, meaning that 
you'll spend more time designing, and less time waiting, when using the 
program. 

More Flexibility 
I use that word a lot, don't I? But it's important. To me, and to you. In this case, 
you can load a standard, published map, which only requires the Basic palette, 
then without fouling anything up, load the Intermediate or Advanced palette for 
making changes with using the more advanced graphics and paths. If you use the 
added graphics, they're included for the map. If you don't, then when saving the 
map, it defaults to the lower graphics palette (kind of the way saving a 'Mech in 
HMPro while using Level 3 rules saves it as a Level 1, if you've used only Level 
1 equipment in your design). You get to design with the tools you want, yet save 
time when you can. 
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Faster Map Loading 
 If a map uses the Basic palette, and if when you load it you already have the 
Advanced or Intermediate palette loaded, then no graphics need be loaded. The 
program knows that the current palette includes all of the graphics for the map 
being loaded. 

Included Standard Palettes 
Three Standard Palettes are included with HeavyMetal Map: 

Basic Palette 
The smallest palette, including roughly 250 files taking 6 MB of memory, is the 
normal default. Despite its smaller size, most of the standard CBT maps can be 
designed using it and it contains all of the basic terrain types. The Basic palette 
is technically a standalone palette, as it requires no other palette graphics to be 
loaded first. 

Intermediate Palette 
This palette "builds on" (more on that later) the Basic palette, adding 
approximate 350 additional graphics taking 8 MB of memory. It contains all the 
additional paths for multi-hex buildings, such as on the City Skyscraper map, 
and many other useful graphics. 

Advanced Palette 
This palette builds on the Intermediate palette, adding approximately 200 more 
files taking another 4 MB of memory, including all Maximum Tech advanced 
terrain types and many additional graphics, such as Railroad and Maglev paths. 

Custom Palettes 
The All Palette 

The included palette named All is grouped with the Custom palettes, as you are 
allowed to change it (you can't change the Standard palettes). Mostly, this 
palette includes all of the graphics included with the program in a single palette, 
making it a good start for designing your own custom palettes. 

Modifying Palettes 
Modifying Standard Palettes 

That's a teaser, actually, because you cannot normally modify the standard 
palettes, and there's a good reason for that. We need to know, when loading a 
map, what graphics were used to design it. So that you can easily swap map 
designs with your friends or on the Net, we need a basis from which to start. 
And the three Standard palettes (Basic, Intermediate and Advanced) are them. 
You should not try to change these palettes, but rather create your own Custom 
palettes, when you have the need. 
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Modifying Custom Palettes 
With Custom palettes, you can make any changes you like. If they don't build on 
other Standard palettes, they will take a bit longer to load, but it gives you 
additional flexibility to change any graphic you want. You can draw your own 
trees, use photos, and basically design everything from scratch. When you get 
into that, you're going to need to work using the Palette Management screen: 

Creating and Modifying Palettes 
The Palette Management Screen is reached from the main screen menu, 
selecting Map Options > Palette Management. The screen is shown below, and 
has several components which will be discussed individually. 

Palette Management Screen 

 
Top Buttons 

When you first open the Palette Management screen, the current palette 
information will be displayed. If the palette is one of the Standard palettes, you 
will not be able to change it; however, you can make changes and then Save the 
palette using a new name, with the Save Palette As button. Once you've saved 
the palette with a new name, or are working on a Custom palette, you can Save 
Palette Changes as you are working on it. You may choose to Edit Another 
Palette to load a new palette into memory, for viewing or editing. You can also 
Delete a Palette to eliminate those not required, although you are not allowed to 
delete any of the standard palettes. 



 

Group Information 
The palette is organized the same as the group graphics, so you first select a 
Group Information item from the list, to choose which type of graphic to display 
or change. When you choose a group, the list of the Hex Items is updated. 

Hex Items 
Clicking on an item in the Hex Items list shows the graphic specified as well as 
any other information applicable to that item. 

Notice that for palettes that build on other palettes, the graphics of the palettes 
which they build on are normally not included, as they would duplicate the disk 
space for no gain. Therefore, graphics which are not used are usually removed, 
and this can easily be accomplished from the menu selection Utilities > Remove 
Unused Graphics. 

Further, any graphics which are not a part of the selected palette, but which are 
a part of the palette that it builds on, will be shown grayed-out (disabled) in the 
listing. While the information for them will be shown, the filename and graphic 
will not be available, and no changes can be made to any such item. To change 
an item in a built-upon palette, you must load that palette itself. 

Hex Information 
The information in this area updates as you choose a hex item. You can modify 
any of that information, and after doing so, must click on the Save Hex button. 
Note that this saves the hex information to memory, but does not yet save the 
palette itself. 

Graphic Filename 
The filename of the graphic used for the selected hex item is displayed, and a 
preview of the graphic is shown in the Hex Graphics area. Note that the correct 
filename is chosen when you select the hex item; if you click on another 
graphic, the preview of it will be shown, but you will not have actually changed 
to another graphic unless you click on the Save Hex button. 

Note also that you can choose whether to allow Flipping or Mirroring of the 
graphic selected, or both. Normally, all are allowed, but you can limit the choice 
where it either makes no difference, or doesn't work out well. 

You can also choose to view a Preview of the hex graphic, a large, full-sized 
version for examination of the smallest detail (although without the flipped or 
mirrored versions). 

Path Graphics 
The Natural path and the two manmade paths, Lower and Upper, are special 
cases in palette graphics. While the properties, such as Rules, Height and CF, 
apply to the entire path, it takes as many 23 separate graphics in order to draw a 
path in HeavyMetal Map. Actually, it takes a lot more, but the program 
automatically flips and mirrors the 23 graphics to produce the required paths. 
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Therefore, when designing or modifying a Path, there are 23 separate graphics 
that must individually be specified, plus an additional one to display for the path 
button. Yes, this takes a lot of work, but it saves so much time when drawing 
paths. Just appreciate the fact that HeavyMetal Map provides approximately 500 
separate graphics for you to use when drawing these paths.  ;-) 

To set or change graphics for paths, you first choose the button which represents 
the path shape you want to specify, then select the graphic filename in the list, 
and click on the Save button in the Path Segments portion of the screen. 

Palette File Organization 
While you don't need to know this in order to use the program, you may want to 
know that each palette is actually a series of files and subdirectories located 
within the \Palettes folder of the HeavyMetal Map install folder. So the Basic 
palette is located in the \Palettes\Basic folder, and consists of a single palette file 
(named Palette.pal) as well as a number of subfolders, with files within those 
subfolders. When the program loads a palette, it changes to the palette's folder, 
and loads that palette file as well as all the graphics contained in the subfolders. 

When using the Save As button, therefore, the program is actually duplicating 
the entire folder structure containing the files contained in the palette. Likewise, 
when Deleting a palette, the program is actually deleting all files and folders 
contained in the palette. Deleting cannot be undone, so be careful with it. Also, 
you cannot delete the Standard palettes included with the program, as they are 
required for the published maps. 

An advantage of this palette file and folder organization is that you can zip up 
the entire palette folder, along with its subfolders and files (keeping the folder 
names when making the zip), and then make that palette available to someone 
else. You can even design your own palette from scratch, and use it to make 
completely different maps than provided with the program, using completely 
different sets of graphics, and easily allow others to load the maps by including 
the palette as well.  
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Advanced Operations 

Changing Elevation Level Graphics 
Although graphics for specific elevation levels from 1 to 10 and sublevels from 
negative 1 to 10 are provided, along with levels 1 to 4 with separate grass-style 
graphics, you aren't limited to only those elevations. On the contrary, in addition 
to adding elevation levels to the palette, you can redefine what level any single 
Elevation graphic represents. You can, for example, change the Level 10 graphic 
to a Level 25, to have a super-high plateau on your map. To do this, right-click 
on an elevation level button you want to change. Doing so pops up a Change 
Elevation dialog box, and you can type in the elevation level desired (25 in the 
above example). To change it to a Sublevel (below 0 level), simply type in a 
negative number, like -25. 

After making the change using this procedure, the new elevation will be 
displayed on that level button, and any graphics on the map already using that 
level graphic will be changed to the new level, and a dialog box will tell you 
how many hexes have been changed. You cannot have two different levels 
assigned to the same graphic. But with 24 different graphics to choose from in 
even the simplest palette, you should have plenty to go around. 

Changing Water Depth Graphics 
Like Elevation Levels, Water graphics can have their depths changed to 
represent a different water depth. Graphics for specific water depths from 1 to 
10 are provided, but you aren't limited to only those depths. In addition to 
adding lake depths to the palette, you can redefine what depth any single Lake 
graphic represents. You can, for example, change the Depth 10 graphic to a 
Depth 25, to have an extra-deep sea trough on your map. To do this, right-click 
on the Depth group button you want to change. Doing so pops up a Change 
Depth dialog box, and you can type in the depth desired (25 in the above 
example). 

After making the change using this procedure, the new Depth will be displayed 
on that level button, and any graphics on the map already using that depth 
graphic will be changed to the new depth, and a dialog box will tell you how 
many hexes have been changed. You cannot have two different depths assigned 
to the same graphic. 

Ending Paths Abruptly 
As described above in the example about Paths, most paths have a logical end to 
them. Most roads have cul-de-sacs, or turnarounds, at their ends. Rivers are 
designed to flow into lakes, so have a transition for that purpose. However, you 
can change the way they end, or even end them abruptly. 
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Cutting Paths Off Abruptly 
Any path can be ended abruptly, or even portions of the path removed along its 
length, by clicking the Clear button for that path, then clicking on the hex for 
which the graphic is to be removed, or press and hold the Shift key when 
clicking. This removes the graphic, and does not add a transition of any kind, 
which can be desirable on occasion. Note that using Ctrl-click removes the path 
graphic, along with any other graphic located in the hex; basically it clears the 
hex. While Shift-click removes only any graphic of the selected graphics Group. 

Adding Details to Paths 
Although this is listed in Advanced Operations, it's really used pretty often with 
paths, even those used on the basic maps. Details are often used to add, or alter, 
the ends of paths. For example, when drawing the River path, both ends will 
have a short transition intended to end into (and over) a Lake. This covers the 
bank area of the lake, and makes for a good-looking transition. However, rivers 
don't begin this way. Therefore, among the Details included in the program are 
River Ends, which can be placed over the ends of River paths. This makes for a 
more natural beginning for the river. 

Similar Details can be used on Roads, Buildings (to make a chopped-off 
building corner a sharp angle instead) and other graphics. 
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Custom Graphics 

Making Your Own Map Graphics 
Designing Your Own Graphics 

Making your own graphics for use with HeavyMetal Map requires a painting 
program, such as PhotoShop or Paint Shop Pro (my weapon of choice). The 
included Paint program provided with Windows can be used for something very 
simple, like the tiled Background graphics or a rectangular Add-On graphic, but 
is not sufficient for Hex graphics. 

For those who become very involved making their own graphics, you will 
quickly find that the ability to use Layers within the graphic file is almost a 
necessity. You must be able to produce groups of graphics which align and/or 
mesh with one another to produce pleasing results for use on maps. 

Using the Graphics of Others 
I anticipate that after HeavyMetal Map is released, there will be many users who 
produce their own graphics, some of whom will be willing to share. A 
HeavyMetal Map Graphics Contributions web page is set up at 
heavymetalpro.com and I will be periodically posting maps, graphics, and entire 
palettes submitted by users of the program. 

Therefore, even if you’re not a graphic artist, or don’t have the graphics tools 
you need to design quality graphics, there should be a large number of additional 
graphics available to you. 

Types of Graphics in HeavyMetal Map 
Hex Graphics 

All of the hex graphics (as differentiated from Background, and possibly Add-
On, graphics) have very specific properties, which must be followed in order to 
customize or make new hex graphics for use by the program: 

 Hex graphics must be in GIF format, which can contain up to 256 colors. 

 Individual Hex graphics do not need to use the same 256 colors; neither 
do they need to always use 256 colors. The high-color requirement of the 
system accommodates this. 

 Pure Magenta is used to denote a transparent area of the graphic. Any 
pixel that has an RGB value of 255,0,255 (#ff00ff in hex) is considered 
pure Magenta. 

 Transparent areas normally include all areas outside the actual outline of 
the hex, as well as any other areas which are desired to be transparent. 

 Any magenta variation, even one point off (such as 255,0,254 or 
255,1,255) will not be interpreted by the program as transparent, and will 
be displayed and printed in its true color. 
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 When making images, usually using a program such as PhotoShop or 
PaintShop Pro, care should be taken that when adding the magenta color, 
or making other colors back up to it, that “fringes” of magenta-like 
colors are not produced, because this makes for ugly fringes on the 
graphics. 

 Hex graphics are exactly 287 x 287 pixels in size, overlapping the sides, 
top and bottom of the hex itself. This gives added flexibility in the 
graphics. 

 Hex outlines are designed to have a 222 pixel flat-to-flat vertical pitch 
and a 256 pixel point-to-point horizontal pitch. 

 Master GIF images showing the exact hex outline, as well as the outer 
magenta mask, are included in the Reference subfolder of the program. 
These can be used to assist in making new hex graphics. 

 A Master Paint Shop Pro image is included in the Reference subfolder as 
well, to assist in the making of custom hex graphics. 

 For Path graphics, a total of 23 separate and distinctive hex graphics 
must be included to form a complete path. If all 23 graphics are not 
available, at least some path combinations or intersections will not be 
able to be made. 

 Paths also require a small button graphic, 37 x 37 pixels, which can have 
a magenta (transparent) area to display on the button used to select the 
path. 

 Water/Lake and Elevation Level graphics should completely fill the hex 
area, including the thin (1 pixel thick) outline of the hex, but not extend 
beyond it. 

 Other graphics can extend beyond the hex outline, in order to appear 
more random or blend better with surrounding hex graphics. It is best to 
experiment with them to see what looks most appropriate. 

 Where textures or patterns are used in neighboring hexes, care should be 
taken that they mesh well with the other graphics, and this is sometimes 
difficult. Random patterns like concrete are much easier to mesh, and 
require much less care, than straight lines or curves. 

 When designing graphics, as well as the patterns used in those graphics, 
you should consider that it is usually desirable to allow the hex graphics 
to be flipped and/or mirrored for more variety. Some patterns, such as 
diagonal lines, make this difficult or impossible. 

 To be used by the program, all hex graphics must be placed into the 
appropriate Palette folder (Details, Terrain, etc.), and also added to the 
appropriate Palette itself from the Palette Management screen. Placing 
the graphics in the wrong location, or not adding them to the palette 
being used, will result in them not being available to the program. 
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Background Graphics 
 Files must be in GIF, JPG or BMP formats. 

 Background graphics should be rectangular, of any desired size. 

 Images will be tiled, beginning at the upper left corner of the map, and 
continuing as many times as necessary to completely cover the map. This 
tiling begins afresh for each map when making multi-map images. 

 Transparency is not considered in Background graphics, so all colors 
will be used as they are. If magenta areas are included in the graphics, 
the final image and printed color will be magenta. 

 Should it be desired to use a full map image, that is, one covering the 
entire background of the map, so that it is not tiled or repeated, the image 
should be exactly 3073 pixels wide by 3775 pixels high. The image 
should include the exact map portion shown on published maps and 
indicated within the zoomed borders of the map within the program. 
Normally, hex outlines and numbers will be added by the program, but 
these can be included on the graphic as well, if desired. 

 No mirroring or flipping of the background images occur when they are 
added to the map, meaning that for best appearance, all images used 
should provide for seamless tiling. 

 To be used by the program, background graphics must be placed into the 
\Backgrounds subfolder. 

Add-On Graphics 
 Add-On graphics must be in GIF, JPG or BMP formats. 

 GIF images are required for any graphic intended to have transparent 
areas. 

 Pure Magenta is used to denote a transparent area of the graphic. Any 
pixel that has an RGB value of 255,0,255 (#ff00ff in hex) is considered 
pure Magenta. 

 The same cautions concerning magenta fringes mentioned above in Hex 
Graphics also apply to Add-On graphics. 

 Graphics are always initially centered on the selected hex, although 
offsets can be used. They can also be resized both vertically and 
horizontally (and not necessarily by the same amount), flipped and/or 
mirrored. This should be considered when designing the size and shape 
of Add-On graphics, to get the most flexibility from them. 

 To be used by the program, Add-On graphics must be placed into the 
\Add-Ons subfolder. 
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Working With Images Made by HeavyMetal Map 
Although not graphics you actually make, the map Images produced by 
HeavyMetal Map in BMP and JPG formats, as well as the multi-map images 
made by the program in JPG format, can be used with various graphics 
programs such as PhotoShop and Paint Shop Pro, both to add additional details 
to, as well as use for printing of the graphics. Please note that working with the 
high-resolution, multi-map images takes a lot of memory, and any paint program 
you use, as well as your computer, must be able to accommodate that. 

When working with JPG images, quality and compression are a primary 
concern, as using too high a compression (and therefore too low a quality 
setting) can add JPG “artifacts” which can look bad both on images and printed 
maps. Due to the nature of JPG images, once they are saved at a low quality, 
you can never get the original quality back, so be careful when you save such 
images. 

Other Required Information 
If you are interested in working on graphics for use in HeavyMetal Map, and 
have a question that this User’s Guide has not answered, please feel free to 
email us at support@heavymetalpro.com. We are proud of our response time to 
email messages, and are willing and able to help you when we can. 
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Frequently Asked Questions 
Q How do I make a 1 page printout of a larger map for reference? 
A You can easily print any map to a single, letter-size (or other size) page from the 

Print dialog box. Just choose “Fit to 1 Sheet” in the Map Size box. 

Q Can I print out maps larger than the standard CBT map sheets? 
A No, you can’t print maps larger than the standard 17 hexes high by 16 hexes wide 

CBT sheet. You can, however, make four-map multi-images, in JPG format, 
which can then be printed, using ay application that prints JPGs and a large 
format printer (or print shop). 

Q Can I make my own Add-On graphics? If so, where do I put them? 
A Yes, you can use any GIF, JPG or BMP graphics file to make your own Add-On 

graphics. Just place them in the program’s \Addons folder, and they will be 
available to you. Make sure you use a GIF or BMP with pure Magenta color for 
any transparency that is required. 

Q Can I make my own Background graphics? I have some I’d like to try. 
A Yes, you can. Any graphic you use should be able to be “tiled”, that is, repeated 

both horizontally and vertically, so you will want to test it to be sure it doesn’t 
leave any obvious “edges”. Just place your graphic, in BMP, JPG or GIF format, 
in the \Backgrounds folder. 

Q I have a map image file that has all of the features “hand drawn” on it. Is there 
any way I can use that in HeavyMetal Map and add features to it? 

A Yes, there is. It must be exactly 3073 pixels wide by 3775 high, or can be resized 
to the size using a paint program. Just use it as your Background graphic, as 
described above. You will probably want to hide hex numbers, lines and any other 
information already on the image. 

Q I don’t like waiting for the Intermediate or another palette to load when loading a 
new map. What can I do about that? 

A For all the standard maps, if you already have the Intermediate palette loaded, it 
won’t have to load it again. Consider making the Intermediate palette (or even the 
Advanced one) your Startup palette, by checking the “Use as Startup Palette” 
checkbox on the Change Palette screen. 

Q My computer is pretty slow, and it bogs down in the middle of drawing graphics 
to update the screen. Can I eliminate this? 

A Yes. This is caused by the Auto-Refresh feature, which is nice to have with faster 
computer. To turn it off, just uncheck Auto-Refresh from the View Options menu. 
You can also make the Auto-Refresh delay longer, if you wish. 

Q When I make multi-map images, my computer really slows down. Why? 
A As mentioned earlier in this Guide, and on the multi-map image screen, making 

these images takes an addition 50 to 100 MB per map sheet, so you can quickly 
run out of memory. When that happens, memory is swapped out to “virtual 
memory”, or hard drive space, which is 50 times or slow slower. For fastest 
operation, make sure you have plenty of extra RAM before making multi-map 
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images. RAM is pretty cheap these days, and you might consider adding some to 
your computer. Selecting Low-resolution maps about halves the memory 
requirement. 

Q Why can’t I change the Basic, Intermediate or Advanced palettes? 
A It is important that the maps provided with HeavyMetal Map be able to have all of 

the graphics expected. For this to occur, the palettes they use must stay the same. 
You can make as many Custom palettes as you like, however, and design your 
own maps using them. 

Q I loaded a map, then changed the palette, and some graphics disappeared or 
changed to the wrong graphic. What’s up with that? 

A If you already have a map in memory that was loaded using a specific palette, and 
change the palette, those same graphics may not be available, or may be in a 
different location within the palette. Normally, this is not recommended, but you 
can still do it, then correct or change anything that is different with the new 
palette. 

Q Some of the fine graphics, like parallel lines in buildings, don’t look very good 
when printed. How do I fix that. 

A You can print all maps using low- or high-Resolution. Normally, low-resolution 
works fine, but fine detail can be lost. For the best looking maps, choose high-
resolution when printing. 

Q Why does the palette keep loading, taking many seconds, whenever I load a 
different map? 

A As long as you are using the supplied maps, this shouldn’t happen much. But if 
you make your own maps, and use a different palette on each, the programs has to 
load and switch all the new graphics for the different palette whenever a map 
using that palette is loaded. To help reduce this, try to use one palette, maybe the 
Advanced palette, for designing most of your maps. 

Q Why, when drawing paths, does the rubber-band line limit what hexes I can draw 
to? 

A Since HeavyMetal Map is a hex-based map program, you can only draw roads 
and other paths between hexes, and hexes are located at 60 degree angles. 
Therefore, all roads must be drawn at one of the possible six 60 degree angles. If 
you could click on a hex not within the 60 degree angle, there would be more than 
one path that could be made to get there, and the program would have no way of 
knowing which to take. 

Q Why do the preview images on the Open screen for my custom maps look different 
(better or worse) than those provided with the program? 

A The map previews shown on the Open screen are actually a screen capture of the 
design screen map when you save the file. If your window is smaller, so the map 
image is smaller, the preview will be too, and will be stretched to fit the window. 
Therefore, it may not look as good, or even just different, than those produced on 
the computer that made the standard maps. 
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Q I’m having trouble seeing all the hex information and still getting a good view of 
the map. What can I do to help? 

A First, make sure you’re running your computer at the highest resolution you’re 
comfortable with. That should be at least 1024 x 768 resolution, but higher is 
much better. Also, if you’re using the Windows Large Fonts setting (from the 
Advanced Display Properties screen), it takes space away from the actual map 
area. In any event, play with the Windows settings as well as the program’s Zoom 
settings until you’re happy with the result. 

Q Every time the program starts, it comes up with an bright green color that I don’t 
like. I can change it, but how do I make it so it comes up with the color I want? 

A The Background button at the upper left controls what color, or graphic image, is 
used to make the background of the map. You can change the color there, or set a 
graphic to be tiled across the map. If you want it to be the default, and be shown 
whenever the program starts or you start a new map, make sure you check the 
“Use as Startup for new Maps” checkbox before clicking OK. 

Q I don’t have a large format printer, and I think that taping together 9 sheets for a 
standard map is a bit much. What can I do about that? 

A Of course, you can take an image to a print shop and have them print the map in 
one piece, but you can also “cheat” a bit and save yourself some tape (and 
aggravation): Change the printout to fit to 2 x 2 sheets, which changes the hex 
size from 1.29” to 1.14”; the hexes only about 1/8” smaller, so are still usable, but 
you need less than half the number of sheets. 

Q I have a map that’s mostly covered with woods, and the Map Information sheet 
shows all the hexes they’re in, but they’re too small to read. What’s up? 

A In order to show information on all important hexes on the Map Information 
Sheet, all of the hex numbers have to fit in a specific area. If there are a lot of 
them, they get pretty small. But obviously at this point you know what is in most 
of those hexes, so just use the other terrain to help determine what is in a specific 
hex. 

Q I’ve pressed the normal Windows F1 key, and don’t get any online help. Where is 
it? 

A Well, we have found that most people don’t use the online help much. So in 
HeavyMetal Map have instead concentrated on giving you a comprehensive and 
searchable User’s Guide, which is this guide. It is printable and, due to its format, 
has much more information and examples than could ever be put into a traditional 
Windows help file. Most important, you can easily browse to view all of the 
information, while with a help file you only see specific screens. We feel that 
especially for HeavyMetal Map, the User’s Guide is the way to go, and hope that 
you agree. 

Q I sent a custom map to a friend by email, and he says it won’t open properly, or 
the graphics aren’t right. How do I fix this? 

A You probably designed the map using a Custom palette, one that your friend 
doesn’t have. You have two choices: Design your maps using the standard three 
palettes, as all users have them available; or Zip up the palette you used, and send 
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it to him as well. Then, he or she will have the palette you used to design the map, 
and everything will work fine. 

Q I’d like to send some of my maps to a friend who doesn’t own HeavyMetal Map. 
How do I do that? 

A Well, first, you should encourage your friend to buy the program.  ;-)  But lacking 
that, you can save your map as an Image, and then send the image (usually a JPG 
file) to your friend. He or she can then open the image with any graphics program 
such as Windows Paint, or even view it using a web browser. 

Q I have a map that has a lot of both light and dark colors, and the text in the hexes 
is not very clear. What can I do about that? 

A In addition to being able to change the text size, color and boldness, you can also 
choose a white text with black outline, or black text with white outline, option. 
This makes the text very readable on all colors of graphics. 

Q I’m a Gamemaster, and I like to keep my players just a bit in the dark about 
things. For example, I don’t want them to know that a building is a Hardened 
class before they open fire. How can I keep that off the map? 

A On the Map Properties screen, you can set many map options and one of them is 
what text, if any, appears on such buildings. You can show the CF (Construction 
Factor), Class and Height; the Class and Height; the Height only (probably what 
you want) or nothing at all. Note that the Map Information Sheet will still have 
this information, but you can keep that to yourself. 

Q When I’m drawing new roads and buildings, sometimes I think I’m on a different 
level than paths already on the map, but when I go to draw over them, it replaces 
them with the new path. This causes me extra work. What can I do about it? 

A First, don’t forget that you have an Undo function. Pressing the Ctrl-Z shortcut (or 
using Edit > Undo from the menu) will restore the map to the way it was before 
choosing the last path, graphic or group. This usually gets you out of trouble 
quickly. If you’re unsure of what path (Upper or Lower) or graphic layer is 
actually in a hex, use the Hex Info button to display it. 

Q Sometimes when I’m making random maps with the shortcut keys, I see one I like 
but make another one before thinking about it, and wish I could go back. Can I? 

A Yes, Undo works here, too. In fact, you can make up to ten different random 
maps, then switch back and forth between them using Undo and Redo, to find the 
one you like best, before using it as for a game or basing a new map on it. 

Q Can I change the random settings on the I’m Feeling Lucky feature? 
A No, it is intended to be truly random, so you don’t have any control over it. Just 

hit F12 enough times, and you’ll probably find something you like. Don’t forget 
that you can change all the random parameters from the Random Map Designer 
screen, then make multiple maps with it using the F11 key, until you find 
something you’re happy with. 

Q I like the hex-edge Walls, but would like a break in them. Can I do that? 
A No, the hex-edge walls are intended to completely enclose an area. But you can 

add a wall Gate from the Details graphics, to make road or path access. 
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Q I’ve drawn a large mountain, and placed a snowcap on it using Deep Snow 
terrain, but it’s not visible. What’s up? 

A You have a choice with the order that you draw the Elevation Level graphics: 
Above the Terrain graphics, or below them. The condition you describe has them 
Above the terrain, so the snow isn’t visible. Go to the Map Properties screen, and 
on the Level Graphics tab select the second option. This will allow you snowcaps 
to show properly. 

Q I sent a friend a neat map I made with a custom DropShip I drew up on it, but 
even though I’m using the Basic palette, the DropShip didn’t show up? Why not? 

A Add-On graphics are not part of the palette; they are loaded separately. If you 
send your friend a copy of your DropShip graphic, and he places it in his \Addons 
folder, it will display properly. 

Q I don’t want to see the Elevation Level graphics on the map, and have unchecked 
it in the View Options menu, but they still show up on map previews. What’s up 
with that? 

A The View Options menu only determines how the map appears while you are 
working on it. Therefore, the Previews, as well as printed maps and saved images, 
are not affected by the View Options settings. You can, however, change the 
properties of the map on the Map Properties screen, and there hide elevation level 
graphics, hex text and other information as desired. 
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Glossary 
2D Maps – See Map Sheets. 
3D Maps – Maps that have been modified, or built from scratch, to have the height of elevation 

levels indicated by an actual increase in the height of the map. Often used in more 
advanced CBT play. 

Add-Ons – In HeavyMetal Map, and Add-On graphic is one that is drawn last over all map 
graphics, and which can be resized, flipped or mirrored as desired. 

Advanced Palette – The palette used for designing custom maps and maps with more advanced 
and complex graphics. See also Palette. 

Auto-Refresh – A function that automatically refreshes, or redraws, the map screen during the 
process of map design. 

Auto-Refresh Delay – The delay in seconds that the Auto-Refresh function uses when refreshing 
or redrawing the map screen. 

Autorun Program – A program that automatically runs when a CD is placed into a CD Drive. 
Background – The background of a map in HeavyMetal Map, which can be a plain color 

(including white), but is most often a graphic providing a pleasing area for clear hexes on 
the map. 

Basic Palette – The palette used for the more basic published maps, and useful on computers with 
less memory and speed. See also Palette. 

BattleMech – The ultimate war machine of the 31st century, BattleMechs rule the battlefield. 
Weighing 20 to 100 tons, and towering up to 15 meters (50 feet) high, they are an 
imposing site. 

BattleTech – See Classic BattleTech. 
Bit – A single binary digit, 8 of which make up a Byte. See Byte. 
BMP – A Windows bitmap graphic format, used by Microsoft Paint and some older painting 

programs. BMP files are lossless, but take up a lot of space. 
Bridge Rating – The Construction Factor of the bridge, which also equals the tons that the bridge 

can support. See also Structure Classes. 
Building Classes – See Structure Classes. 
Build-On Palette – A palette that builds on, or adds graphics to, one or more other palettes, which 

are loaded first. 
Byte – A string of binary digits (bits), usually 8, operated on as a basic unit by a computer. The 

basic unit of storage capacity in a computer system. See Megabyte. 
CBT – See Classic BattleTech. 
CD Drive – A computer drive capable of reading a compact Disc (CD). 
CD-ROM – Standing for Compact Disc – Read Only Memory, it is a means of mass storage that 

can hold as much as 700 MB on a single CD. The ROM means that information can be 
read from it, but not written to it. 

CF – See Construction Factor. 
Classic BattleTech – The latest incarnation of the 20 year old game of BattleTech, a great 

tabletop game usually played with map sheets and BattleMech miniatures. 
Color Setting – Windows can be set up with varying numbers of colors, from 16 (only for 

extremely old systems), through 256 (also uncommon, these days) to 16-bit (millions of 
colors), 24-bit and even 32-bit color. HeavyMetal Map requires a minimum of 16-bit 
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color to display map graphics properly. Note that hex graphics within HeavyMetal Map 
use GIF files capable of only 256 colors, however the combination of many of them make 
for the 16-bit color requirement. 

Colors – See Color Setting. 
Compact Disc (abbreviated CD) – Spelled with a C in disc, rather than the K used for a hard disk 

or floppy disk, a compact disk is the most common form of distributing for software 
programs, and can contain up to 700 MB of data. 

Construction Factor – A rating of the strength of a bridge, building or wall, ranges from 1 to 150. 
It also represents the number of damage points required to destroy the object. See also 
Building Classes. 

Control Panel – The program used in Windows to control most of the operation of Windows, 
including the display, hardware and what programs are installed. Can be reached using 
the Start menu with Start > Control Panel (for Windows XP) or Start > Settings > Control 
Panel (for other Windows versions). 

Copyright – The exclusive right to the publication , production, or sale of the rights to, among 
other things, a software program. All HeavyMetal software is copyrighted by RCW 
Enterprises, and cannot legally be given or sold by others. Please see the EULA and 
Copyright Notice in this User’s Guide. 

Default – Having nothing to do with not having enough money to pay the car payment, the 
default value of a software program is the normal value, the one automatically set by the 
program, until changed by the user. 

Desktop – The Windows Desktop, the visible area shown after Windows is started, and often 
used to contain shortcuts to programs and data. 

Details – In HeavyMetal Map, a type of graphic that is drawn toward the end of the drawing 
process, and so can therefore be used to add details to other map graphics. 

Directory – A collection of files and/or other directories which help organize any computer’s 
files. Also known as a Folder. 

Double-Click – Clicking twice with the left (main) mouse button without hesitation, which is 
different than two separate clicks separated by a pause. The time of the pause that is 
considered a double-click can be defined by Windows. 

DropShip – An aerospace vessel capable of inter-planetary (but not inter-stellar) space travel, 
often carried by WarShips, and used to “drop” ‘Mechs, materials and other resources for 
planetary assaults and other purposes. 

Elevation Levels – Elevation levels on maps are represented by Levels (above the ground around 
them) and Sublevels (below the ground around them). In HeavyMetal Map levels are 
drawn using “cliff” graphics as well as optional graphic patterns that help identify them. 
On CBT maps, a level is considered to be 6 meters high. 

End User License Agreement  - See License Agreement 
EULA – End User License Agreement. See License Agreement. 
FanPro – Short for Fantasy Productions, FanPro is the new publisher of Classic BattleTech 

publications. 
FAQ – See Frequently Asked Questions. 
FASA – The company that originated the BattleTech universe more than twenty years ago. FASA 

went out of business in 2001, but FanPro and WizKids, Inc. have continued with the 
production of Classic BattleTech products. 

HeavyMetal Map User's Guide  Page 81 of 91 



 

Filenames - Maps data files are saved using the normal Windows filename rules, and with the 
.HMX extension (indicating HeavyMetal Hex Map). Allowable characters in filenames 
vary a bit from country to country, but in general, any letter, number and most type-able 
characters can be used except for the following: = * / : < > ? \ | 

Flip – To flip a map or graphic vertically, that is, inverting the image so the top is at the bottom 
and vice versa. 

Folder – A collection of files and/or other folders which help organize any computer’s files. Also 
known as a Directory. 

Folder Tree – A tree-like view of the folders, or directories, on a computer’s drive(s). 
Font Settings – Windows provides for varying sizes of fonts for screen display. These are 

commonly referred to as Small Fonts (the default setting) or Large Fonts (more common 
with very high resolution displays). 

Fonts – A group of characters (letters, numbers and symbols) used to display text and simple 
graphics. Also see Font Settings. 

Forum – In today’s terms, a web site set up where people can communicate with each other, and 
in particular, with the developers or others who represent software manufacturers. There 
are many forums for those interested in Classic BattleTech. 

Free Memory – The memory available after Windows has started, as well as any other programs 
running. Can be viewed from the Performance tab of the Windows Task Manager. Total 
Available Physical Memory is the figure we’re most interested in here. 

Frequently Asked Questions (abbreviated FAQ) – Questions which come up often enough that it 
is helpful to make them available to everyone right up front. 

Function Keys – The F1 through F12 keys across the top of most keyboards often used by 
software programs to quickly access program functions. There are usually other (more 
time-consuming) ways of accessing those same functions. 

Gamemaster (or Game Master) – An organizer of RPG or other types of games, which benefit by 
a single person to help guide the game into new and interesting areas. Also acts as a 
referee on occasion. 

GB – See Gigabyte. 
Gigabyte – Approximately one thousand million bytes of memory. As computers always work in 

multiples of 2, a Gigabyte is actually 1024 x 1024 x 1024 = 1,073,741,824 bytes. 
Graphic – Any of various types of pictures used, in this case, to make or enhance map sheets. 
Graphic Groups – Groups in HeavyMetal Map represents groups of graphics (which in turn are 

selected by buttons). For example, Terrain is a group within the program, as are Features, 
Paths and Details. 

Graphics Buttons – The buttons which represent the individual graphics contained within each 
group of graphics. 

Groups – See Graphic Groups. 
Hex – In Classic BattleTech, a map hex is used for play, to determine location and facing. A CBT 

hex is considered to be 30 meters in size from flat to flat. 
Hex Edge Walls – See Walls. 
Hex Numbers – Each hex of a CBT map is usually marked with a number to identify the hex. 

This is useful in identifying the location of hidden units and artillery strikes, and also for 
recording the  location of units between games, so they can be placed in the correct 
position. Most CBT maps begin numbering with 0101 at the upper left corner of the map. 
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HMX File – A HeavyMetal Map data file that contains all of the information required to load the 
map into HeavyMetal Map, including a small graphic preview of the map. All 
HeavyMetal Map files have an HMX extension (such as “MyMap.hmx”). 

I'm Feeling Lucky! ;-) – A feature in the Random Map Designer of HeavyMetal Map that designs 
a random map from scratch, without using the predefined percentages normally used. 

Image – Any graphic picture, but in HeavyMetal Map usually used to refer to the BMP or JPG 
images that can be made by the program of individual maps or multiple maps. 

Information Prompt – Many software programs, including HeavyMetal Map, often have useful 
information at the bottom of the screen to assist in the current operation. 

Install Program – See Setup Program. 
Installation Folder – The Windows folder, or directory, into which a program is installed. In the 

case of HeavyMetal Map, the default installation folder is c:\Program 
Files\HeavyMetal\Map. 

Intermediate Palette – The palette used for the more complex published maps. See also Palette. 
JPG (also JPG) – A lossy graphic format commonly used for photographs and other high-color 

graphics. The quality of a JPG file can be varied to provide small size or high quality (but 
not both). 

KB – See Kilobyte. 
Kilobyte (abbreviated KB) – Approximately one thousand bytes of memory. As computers 

always work in multiples of 2, a Kilobyte is actually 1024 bytes. 
Lakes – In HeavyMetal Map, a term used to describe any water area, with a depth of zero or 

higher, and normally occupying at least several hexes. Also used for seas or shoreline 
areas. 

Large Fonts – See Font Settings. 
Layers – In HeavyMetal Map, graphics are grouped into layers when being drawn to the map, so 

that the order of what graphics cover others is known and consistent. 
Levels – See Elevation Levels. 
License Agreement (also EULA or End User License Agreement) – An agreement between, in 

this case, RCW Enterprises and the users of HeavyMetal software, which specifies 
exactly what can and cannot be done with the software. 

Local Refresh – This is an option in HeavyMetal Map that automatically redraws the six hexes 
surrounding the actual hex being modified. It can keep the appearance more exact, as 
when drawing a single hex, it can incorrectly overlap into neighboring hexes. But it takes 
a fast computer to use, and some people – like me – don't really like the rippling 
appearance during drawing. 

Lossless – A term relating to a graphic file format that loses none of its graphic information. 
Some, like PNG files, are compressed, while others, like BMP, are not. 

Lossy – A term relating to a graphic file format that loses some graphic information during the 
compression process. JPG files are the best example of these. 

MagLev – Stands for Magnetic Levitation, a monorail-like train which is powered using 
electronic magnets in the track and train which repel each other to produce motion. 

Main Screen – The main screen within HeavyMetal Map where the vast majority of design work 
occurs. 

Manmade Path – A special graphic type in HeavyMetal Map, used primarily for drawing Roads, 
Walls and multi-hex Buildings in a path configuration. 
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Map Information Sheet – In HeavyMetal Map, an optional printed sheet or sheets that contains a 
key of all graphics on the map that have an effect on playing the game, such as its CF, 
height, to-hit modifiers or other rules. 

Map Design Area – the central portion of the HeavyMetal Map main screen, used to display and 
design the map. 

Map Sheets – Maps that are two-dimensional, such as the standard, published map sheets 
produced by FASA and FanPro for use with Classic BattleTech. Published map sheets are 
usually 18” x 22” in size. 

MB – See Megabyte. 
'Mech – See BattleMech. 
Megabyte (abbreviated MB) – Approximately one million bytes of memory. As computers 

always work in multiples of 2, a Megabyte is actually 1024 x 1024 = 1,048,576 bytes. 
Memory – With computers, RAM (Random Access Memory) is most important, as it is much 

faster than Virtual Memory (disk space set aside for this use), and is used both by 
Windows itself as well as the programs that Windows runs. 

Menu – The Windows or application menu tree, usually located across the top of a Windows 
program, and used to access many functions, such as Open and Save. 

Menu Tree – The tree-like structure of the menu for a program. See also Menu. 
Mirror – To mirror a map or graphic horizontally, that is reversing the image so that the right side 

is at the left and vice versa. 
Monorail – A type of train support system, usually elevated, where the train rides a central ridge, 

or monorail, rather than the traditional two railroad rails. This arrangement provides for 
more security and higher speed, along with more flexibility in providing support. 

Most Recently Used Files – Also known as MRU, these are the last several files that were opened 
or saved using the program. 

Mouse – The little pointing thingy used to operate Windows and other graphics programs, named 
because of its “tail”, despite the fact that cordless mice don’t have cords (or, therefore, 
tails). 

MRU – See Most Recently Used Files. 
Multi-Hex Building – A building drawn in HeavyMetal Map using a Path type of graphic, where 

the outline of the building is drawn using the rubber-band method, and the center area 
filled in as desired. 

Multi-Map – A term used in HeavyMetal Map to describe a two to four map combination image. 
Can make very large images for use in paint programs or for printing. 

My Computer – An icon on the Windows desktop representing the computer, including its 
hardware, attached peripherals such as printers, and hard drive folders. 

Natural Path – A special graphic type in HeavyMetal Map, used primarily for drawing Rivers and 
other natural features in a path configuration. 

Newsgroup – A signup listing, hosted by Yahoo Groups or other host, which is used to notify 
(send newsletters) to those interested in a particular subject or product. 

Operating System – These days, the OS usually refers to the version of Windows being used, 
such as Windows 2000 or Windows XP. 

Palette – In HeavyMetal Map, a palette is a group of layers, each of which contains graphics to 
produce specific map features, paths and details. 

Path – A Natural or Manmade Path in HeavyMetal Map. See Natural Path and Manmade Path. 
PBM – See Play-By-Mail. 
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PDF – Portable Document File, authored by Adobe and created by Adobe Acrobat, this file 
format is often used to make documents produced by any program readable to all, even 
without the program it was produced with. Adobe Acrobat Reader and other free PDF-
reader programs are available. 

Pentium Processor – A class of Intel processor. AMD makes an equivalent. 
Pixels – Standing for Picture Elements, the small dots used to create text and graphics on a 

computer screen or printout. 
Play-By-Mail – A method of playing CBT and other games, usually be email. 
RAM – Random Access Memory, computer memory which is usually volatile (is lost when 

power is removed) and fast. See also Memory. 
Random – Occurring at random and not controlled by any particular sequence. HeavyMetal Map 

has a Random Map Designer that allows quick and easy designing of maps for play. 
Readme File – A small file included with many programs with very basic information on how to 

install the program or other such information. 
Redo – Goes back to the condition of the map before the last Undo operation was made. 
Refresh – To make new, by drawing again. In HeavyMetal Map it is often desirable, during the 

course of designing a map, to Refresh or repaint the screen, to be sure all graphic 
elements are shown properly. 

Resolution – The fineness, or resolution, of any item, with computers most often resolution refers 
to the screen resolution, such as 1024 x 768 pixels. 

Role-Playing-Game – A game in which the players take on roles, as persons or identities, to add 
interest and a personal association to the game. 

RPG – See Role-Playing-Game. 
Rubber-Band Line – A line which stretches and changes its angle to connect two points. Used in 

drawing paths in HeavyMetal Map. 
Runtime Files – Most Windows programs require runtime files, common files that are used in the 

background to help with various functions, such as displaying common dialog boxes and 
producing graphics. File formats for these include DLLs, OCXs and others. 

Setup Program – A program used to “set up” a software program. It typically installs all of the 
files necessary for running the program, including data files and Windows runtime files. 
Most Windows programs require that they be properly set up using a specific setup 
program, rather than just copied to the computer. 

Shortcut – A Windows shortcut which points to an installed program, and is used to start or run 
the program. Shortcuts can be located on the Desktop or within the Program Files portion 
of the Start Menu. 

Small Fonts – See Font Settings. 
Standalone Palette – A palette that contains all graphics required, and does not depend or build on 

any other palette. 
Standard Palettes – The group of palettes supplied with HeavyMetal Map and intended for use 

with standard, published maps. Should not normally be modified by the users, so as to 
work correctly with the standard maps. See also Palette. 

Structure Classes – The classes of buildings, walls, bridges and other structures in CBT 
established by varying Construction Factors. Light structure are 1-15 CF, Medium are 16-
40 CF, Heavy are 41-90 CF and Hardened are 91-150 CF. 

Terrain – In HeavyMetal Map, a term used to describe the group or layer of graphics which 
normally cover entire hexes and groups of hexes, such as Sand and Deep Snow. 
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Transparent – In HeavyMetal Map, graphics are added to a map in such a way as to have portions 
of them be transparent. This allows a truss bridge to be drawn over a road, without 
obscuring all of the road. In this program, the Magenta color is specifically used as a 
"flag" that the area so colored is to be transparent. 

Undo – Revert to the condition of the map, before making the last change, or series of changes. In 
HeavyMetal Map, Undo reverts back to the map state before the previous group or 
graphic button was chosen. Undo can be used multiple times, in the case of this program, 
up to ten times. 

Uninstalling – The process of removing an installed program from a computer. Don’t even think 
about it!  ;-) 

URL (stands for Uniform Resource Locator) – The web address used to located (browse to) and 
location on the Web or Net. 

Video Settings – The screen settings of a computer, consisting of the screen Resolution and Fonts 
Setting, among others. Also see Resolution. 

Virtual Memory – An area of the hard disk(s) set aside for swapping volatile memory to during 
operation. Virtual memory is dozens of times slower than RAM, which is why a 
computer slows down dramatically when available RAM is used up. 

Walls – Two types of walls exist in HeavyMetal Map: Center hex walls occupy the center of the 
hex and are entered like Paths. Hex-edge walls occupy the edges of the hex, and not the 
center at all. On a map, ‘Mechs can climb over, or even through, such walls. 

WarShip – An inter-stellar aerospace vessel, usually with a K-F drive, capable of almost 
instantaneous travel of distances up to 30 light years and more. Usually carry DropShips 
and other military resources, for both offensive and defensive purposes. 

Web Links – Internet URLs on the Web (www = World Wide Web) used to browse to the 
locations desired. 

Windows – The family of operating systems patented and produced by Microsoft. 
Zoom – Unless used in a Mazda TV commercial, used to vary the size and extent of the map that 

is visible. Useful for getting an overall view of the entire map, and then zooming in to 
view specific details more closely. 
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Copyright Information 
 

Copyright © 2006 by RCW Enterprises. All Rights Reserved. Developed and 
programmed by Richard A. Raisley. 

Microsoft and Windows are either registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. 

WizKids is a registered trademark or trademark of WizKids, Inc. in the United 
States and/or other countries. 

BattleTech, BattleMech and ‘Mech are trademarks or registered trademarks of 
WizKids, Inc. and/or Microsoft Corporation in the United States and or other 
countries. 

Used under license. 

Made in the United States of America. 
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End User License Agreement (EULA) 

This RCW Enterprises License Agreement ("License") is a legal agreement between 
you and RCW Enterprises (and HeavyMetal Software), covering your use of this 
HeavyMetal Classic BattleTech Software ("Software"). Be sure to read the following 
agreement carefully. By clicking on "I Agree" and/or installing the software, you 
will indicate your agreement with them. If you do not agree with these terms, 
then RCW Enterprises is unwilling to license the software to you, in which event 
you should not proceed with installing the software. 

5. Grant of License. The Software is owned by the Author and is protected by 
United States copyright laws and international treaty provisions. Therefore, you 
must treat the Software like any other copyrighted material (e.g., a book or 
musical recording). Purchasing a license for this software, and agreeing to the 
terms of this agreement, allows you the right to use the Software. 

6. Ownership. The Software and documentation are licensed, not sold, to you for use 
only under the terms of this License, and RCW Enterprises reserves all rights not 
expressly granted to you in this License. You own the media on which the 
Software and documentation are recorded but RCW Enterprises retains title to the 
Software and related documentation, and all intellectual property rights therein. 

7. General Use. You may install and Use one (1) copy of the Software on your 
compatible computer. 

8. Server Use and Distribution. You may not install the Software on any server or 
network, or other method intended for use by multiple computers. 

9. Backup Copy. You may make one backup copy of the Software, provided your 
backup copy is not installed or used on any computer. 

10. Home/Work Use. You, as the primary user of the computer on which the 
Software is installed, may also install the Software on one of your home, work or 
laptop computers. However, the Software may not be used on more than one 
computer at a time. 

11. Transfer. You may not give, loan, rent, lease, sublicense or authorize all or any 
portion of the Software to be copied onto another user's computer except as may 
be expressly permitted herein. You may, however, transfer all your rights to Use 
the Software to another person or legal entity provided that: (a) you also transfer 
this Agreement, the Software and all other software or hardware bundled or pre-
installed with the Software, including all copies, Updates and prior versions to 
such person or entity; (b) you retain no copies, including backups and copies 
stored on a computer; and (c) the receiving party accepts the terms and conditions 
of this Agreement and any other terms and conditions upon which you legally 
purchased a license to the Software. 

12. Restrictions. The Software contains copyrighted material, trade secrets, and other 
proprietary material of RCW Enterprises, Microsoft Corporation and WizKids, 
Inc. You agree that in order to protect those proprietary materials, except as 
expressly permitted by applicable legislation, you will not modify, adapt, 
translate, reverse engineer, decompile, disassemble or otherwise reduce all or any 
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part of the Software to human-readable form unless RCW Enterprises provided it 
to you in human-readable form. If you violate any part of this agreement, your 
right to use this Software terminates automatically and you must then destroy all 
copies of the Software in your possession. 

13. Termination. This License is effective until terminated. You may terminate this 
License at any time by destroying all copies of the Software and related 
documentation in your possession or control. This License will terminate 
immediately without notice from RCW Enterprises if you fail to comply with any 
provision of this License. Upon termination you must destroy all copies of the 
Software and related documentation in your possession or control. 

14. Warranty on Software and Media. The Software and its related documentation are 
provided "AS IS" and without warranty of any kind and the Author expressly 
disclaims all other warranties, expressed or implied, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. 
Under no circumstances shall the Author be liable for any incidental, special, or 
consequential damages that result from the use or inability to use the Software or 
related documentation, even if the Author has been advised of the possibility of 
such damages. In the event that the Software media is found to be defective, it 
will be replaced for a nominal CD fee plus shipping and handling, if the original 
is returned to RCW Enterprises. 

This Agreement shall be governed by the laws of the United States Of America. If for 
any reason a court of competent jurisdiction finds any provision of the Agreement, or 
portion thereof, to be unenforceable, that provision of the Agreement shall be enforced 
to the maximum extent permissible so as to effect the intent of the parties, and the 
remainder of this Agreement shall continue in full force and effect. 
 
The Software was developed by RCW Enterprises, 327 West Passage, Columbia, 
South Carolina 29212, U.S.A. 
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Change Palette Screen, 63 
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Changing Palettes, 63 

Clearing Hexes, 33 

Color Settings, 13 

Combining Multi-Hex Buildings, 60 
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Control Panel, 12, 16 

Copyright Information, 15, 87 

Default Folder, 26, 27 

Designing Your Own Graphics, 71 

Desktop Icon, 19 

Details, 30, 54, 55, 56, 57, 58, 59, 61, 63, 70, 72 

Display Properties, 12, 13 

Drawing Order, 51 

Drawing Paths, 31 

Elevation Levels, 32, 45, 52, 57, 69 

End User License Agreement, 88 

Ending Paths Abruptly, 69 

EULA, 88 

Features, 54 

Filename, 47, 49, 67 

Filenames, 37 

Flip & Mirror, 22 

Flip Map Vertically, 23, 42 

Flipping and Mirroring, 30, 49, 54 

Folder Buttons, 26, 48 

Font Settings, 12 

Fonts setting, 12 

forums, 15, 17 

Frequently Asked Questions, 18, 75 

function keys, 24 

Getting Help, 17 

Graphic Groups, 21, 30 

Graphic Layer, 51 

Graphic Layers, 51, 59 

Graphics Buttons, 21 

Hard Drive Requirements, 13 

Hex Edge Walls, 32 

Hex Graphics, 21, 33, 67, 71, 73 

Hex Information, 67 

Hex Numbering, 50 

Hex Numbers, 22 

I'm Feeling Lucky!, 23, 45, 46 

Image Format, 46 

Image Options, 49 

Image Size, 47 

Installing, 14, 15 

Intermediate Palette, 28, 65 

JPG, 13, 24, 29, 46, 47, 48, 49, 73, 74 

Lakes, 53 

Layers, 30, 51, 59, 71 

License Agreement, 15, 88 

Loading and Viewing Maps, 26 

Loading Maps, 64 

Lower and Upper Paths, 54 

Main Screen, 20, 24 

Map Design Area, 20, 22 

Map Information, 27, 36, 39 

Map Preview, 23, 27, 37, 47, 49 

Map Properties, 23, 35, 36, 52, 53, 57 

Map Size, 39 

Memory, 13 

Memory Requirements, 13 

Menu Tree Structure, 23 

Mirror Map Horizontally, 23, 41 

Modifying Palettes, 65, 66 

Multi-Hex Buildings, 55, 60 

Multi-Map, 23, 47, 48 
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Natural Paths, 31, 53, 55 

newsgroup, 15, 17 

Newsgroup, 17 

Open Map File Screen, 26 

Palette File Organization, 68 

Palette Management Screen, 66 

Palettes that Build On Other Palettes, 64 

Path Graphics, 67 

Phone Support, 18 

Print Screen, 38 

Printers, 14 

Printing, 13, 38, 44, 46 

RAM, 13 

Random Map, 10, 23, 24, 44, 45 

Readme, 15, 19 

Redo, 23, 24, 41, 46 

Refreshing the Screen, 32 

Resolution, 12 

Rotate Map 180 Degrees, 42 

Saving Images, 46 

Saving Maps, 36 

Setting Video, 12 

shortcut, 16, 19, 24, 28, 37, 41, 45 

Shortcut, 16, 24 

Standalone Palettes, 64 

Start Menu, 16, 19 

support, 12, 17, 18, 74 

System Requirements, 12 

Terrain, 21, 30, 33, 36, 51, 52, 53, 56, 57, 63, 72 

Understanding Palettes, 63 

Undo, 23, 24, 41, 46 

Uninstall, 16 

User Interface, 21 

Video Settings, 12 

View Options, 23, 32, 42 

Walls, 32, 56, 63 

Windows, 12, 13, 14, 15, 16, 19, 20, 37, 38, 41, 46, 
47, 48, 71, 87 

Zoom, 10, 23, 42, 43 
 

HeavyMetal Map User's Guide  Page 91 of 91 


	Table of Contents
	Introduction
	HeavyMetal Map Description

	Getting Started
	System Requirements
	Operating System
	Pentium® Class Processor
	Video Settings
	Setting Video
	Resolution Settings
	Font Settings
	Color Settings

	Memory Requirements
	Hard Drive Requirements
	Printers
	CD Drive
	Mouse

	Installing the Software
	Starting the Startup Program
	Installing from CD-ROM
	Installing from File Download

	The Startup Screen
	Install
	Readme
	User’s Guide
	Browse CD
	Web Links
	Legal Info
	Exit

	Installing HeavyMetal Map
	Welcome!
	Copyright Information
	License Agreement
	User Information
	Select Packages
	Installation Folder
	Shortcut Folder
	Ready to Install
	Installation Complete

	Uninstalling HeavyMetal Map

	Getting Help
	User’s Guide
	Email
	Forums
	Newsgroup
	FAQ
	Phone Support


	Getting to Know The Program
	Starting and Exiting HeavyMetal Map
	Starting HeavyMetal Map
	Starting using the Start Menu
	Starting using the Desktop Icon
	Double-Clicking a Map Data File

	Exiting HeavyMetal Map

	The HeavyMetal Map Main Screen
	Menu
	Palette Groups and Buttons
	Graphic Info
	Map Design Area

	Exploring the User Interface
	Palette Groups and Buttons
	Graphic Groups
	Graphics Buttons

	Hex Graphic Info
	Graphic Preview
	Flip & Mirror Buttons
	Other Options

	Map Design Area
	Map Window
	Map Outline
	Hex Numbers

	Menu Tree Structure
	Using Shortcut and Function Keys
	Other Main Screen Information
	Information Prompt
	Time and Date



	Getting Maps into HeavyMetal Map
	Loading and Viewing Maps
	Loading Existing Maps
	Open Map File Screen
	Default Folder / Last Used Folder Buttons
	Look In Folder Tree
	Select Map Listing
	Map Information
	Map Preview


	Creating Maps
	Modifying Existing Map
	Creating New Maps from Scratch
	Clear the Screen
	Choose a Palette
	Select a Background
	Adding Graphics
	Flipping and Mirroring Graphics
	Graphic Groups and Layers
	Lake Graphics
	Drawing Paths
	Solid Path / Pavement Areas
	Hex Edge Walls
	Elevation Levels
	Refreshing the Screen
	Clearing Hexes
	Identifying Hex Graphics
	Add-On Graphics

	Map Properties
	Text in Hexes Tab
	Title/Credits/Description Tab
	Hex Outlines Tab
	Level Graphics Tab


	Saving Maps
	Be sure you've entered all the Map Information
	Save Your Map
	File > Save
	File > Save As
	Map Filenames
	Map Preview Image



	Printing Maps
	The Print Screen
	Printer Name
	Print What
	Map Sheets
	Print Pages
	Map Information Sheet

	Map Size
	Standard CBT Size
	Fit to 1 Sheet
	4" Hexes
	Custom Size
	Single Upper-Left Full Size Sheet Only



	Other Program Features
	Editing Maps
	Undo / Redo
	Undo
	Redo
	Undo / Redo with Random Maps

	Other Edit Functions
	Mirror Map Horizontally
	Flip Map Vertically
	Rotate Map 180 Degrees


	View Options Expanded
	Zoom
	Show Whole Map
	Show Map Width
	Manual Zoom
	Hide Map Graphic Info

	Auto-Refresh
	Auto-Refresh Delay
	Local Refresh
	Show Background
	Show Hexes
	Show Elevation Level Graphics

	Random Map Designer
	Random Map Designer Screen
	I'm Feeling Lucky!  ;-)
	Menu Shortcuts to Random Maps
	File > Random with Last Settings
	File > I'm Feeling Lucky!  ;-)


	Saving Images of Maps
	Save Map as Image
	Image Format
	Image Size
	Filename

	Save Multi-Map as Image
	Save Multi-Map Image as JPG Screen
	Memory Use for Multi-Map Images
	Folder Buttons
	Select Map and Map Preview
	Image Options
	Filename
	Adding Maps
	Removing Maps
	Flipping and Mirroring Maps
	Hex Numbering Multi-Maps



	Working with Graphic Layers
	What is a Graphic Layer?
	Graphic Layer Definition
	Drawing Order

	About Graphic Layers
	Listing All Layers
	Background
	Elevation Levels
	Terrain
	Lakes
	Natural Paths
	Features
	Lower and Upper Paths
	Multi-Hex Buildings and Paths
	Details
	Walls (Hex-Edge)
	Elevation Levels
	Add-On Graphics


	Using Graphic Layers to Make Better Maps
	Combining Roads, Rivers and Bridges
	An Example of Layers

	Combining Multi-Hex Buildings
	Multi-Hex, Multi-Level Building Example

	More Complex Examples
	Use Your Imagination


	Working with Palettes
	Understanding Palettes
	HeavyMetal Map Palettes

	Changing Palettes
	Change Palette Screen
	Loading Maps

	Palette Types
	Standalone Palettes
	Palettes that Build On Other Palettes
	Better for Older PCs
	Quicker Palette Loading
	More Flexibility
	Faster Map Loading

	Included Standard Palettes
	Basic Palette
	Intermediate Palette
	Advanced Palette

	Custom Palettes
	The All Palette


	Modifying Palettes
	Modifying Standard Palettes
	Modifying Custom Palettes

	Creating and Modifying Palettes
	Palette Management Screen
	Top Buttons
	Group Information
	Hex Items
	Hex Information
	Graphic Filename
	Path Graphics

	Palette File Organization


	Advanced Operations
	Changing Elevation Level Graphics
	Changing Water Depth Graphics
	Ending Paths Abruptly
	Cutting Paths Off Abruptly
	Adding Details to Paths



	Custom Graphics
	Making Your Own Map Graphics
	Designing Your Own Graphics
	Using the Graphics of Others
	Types of Graphics in HeavyMetal Map
	Hex Graphics
	Background Graphics
	Add-On Graphics
	Working With Images Made by HeavyMetal Map
	Other Required Information



	Frequently Asked Questions
	Glossary
	Copyright Information
	End User License Agreement (EULA)
	Index

